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•	 App Store is a service mark of Apple Inc.

•	 IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license.

•	 Microsoft, Windows, Windows Vista, Internet Explorer, .NET Framework and PowerPoint are either a registered 
trademark or trademark of Microsoft Corporation in the United States and/or other countries.

•	 MicroSaver is a registered trademark of Kensington Computer Products Group, a division of ACCO Brands.

•	 Virtual Remote Tool uses WinI2C/DDC library, © Nicomsoft Ltd.

•	 The terms HDMI and HDMI High-Definition Multimedia Interface, and the HDMI Logo are trademarks or registered 
trademarks of HDMI Licensing LLC in the United States and other countries.

•	 MHL, Mobile High-Definition Link and the MHL Logo are trademarks or registered trademarks of the MHL, LLC.

•	 Trademark PJLink is a trademark applied for trademark rights in Japan, the United States of America and other 
countries and areas.

•	 Wi-Fi®, Wi-Fi Alliance®, Wi-Fi Protected Access®, Wi-Fi Direct® are registered trademarks of the Wi-Fi Alliance®. 
WPA™, WPA2™, Wi-Fi Protected Setup™, Miracast™ are trademarks of the Wi-Fi Alliance®.

•	 Blu-ray is a trademark of Blu-ray Disc Association

•	 CRESTRON and ROOMVIEW are registered trademarks of Crestron Electronics, Inc. in the United States and other 
countries.

•	 Ethernet is either a registered trademark or trademark of Fuji Xerox Co., Ltd.

•	 Google Play and Android are trademarks of Google Inc.

•	 Other product names and company logos mentioned in this user’s manual may be the trademarks or registered 
trademarks of their respective holders.

•	 GPL/LGPL Software Licenses

	 The product includes software licensed under GNU General Public License (GPL), GNU Lesser General Public 
License (LGPL), and others.

	 For more information on each software, see “readme.pdf” inside the “about GPL&LGPL” folder on the supplied CD-
ROM.

NOTES
(1)	The contents of this user’s manual may not be reprinted in part or whole without permission.

(2)	The contents of this user’s manual are subject to change without notice.

(3)	Great care has been taken in the preparation of this user’s manual; however, should you notice any questionable 
points, errors or omissions, please contact us.

(4)	Notwithstanding article (3), NEC will not be responsible for any claims on loss of profit or other matters deemed 
to result from using the Projector.
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Important Information
Safety Cautions
Precautions
Please read this manual carefully before using your NEC projector and keep the manual handy for future reference.

CAUTION
To turn off main power, be sure to remove the plug from power outlet.
The power outlet socket should be installed as near to the equipment as possible, and should be easily 
accessible.

CAUTION
TO PREVENT SHOCK, DO NOT OPEN THE CABINET.
THERE ARE HIGH-VOLTAGE COMPONENTS INSIDE.
REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

This symbol warns the user that uninsulated voltage within the unit may be sufficient to cause electrical 
shock. Therefore, it is dangerous to make any kind of contact with any part inside of the unit.

This symbol alerts the user that important information concerning the operation and maintenance of this 
unit has been provided.
The information should be read carefully to avoid problems.

WARNING: TO PREVENT FIRE OR SHOCK, DO NOT EXPOSE THIS UNIT TO RAIN OR MOISTURE.
DO NOT USE THIS UNIT’S PLUG WITH AN EXTENSION CORD OR IN AN OUTLET UNLESS ALL THE PRONGS 
CAN BE FULLY INSERTED.

DOC Compliance Notice (for Canada only)
This Class B digital apparatus complies with Canadian ICES-003.

Machine Noise Information Regulation - 3. GPSGV,
The highest sound pressure level is less than 70 dB (A) in accordance with EN ISO 7779.

CAUTION
Avoid displaying stationary images for a prolonged period of time.
Doing so can result in these images being temporarily sustained on the surface of the LCD panel.
If this should happen, continue to use your projector. The static background from previous images will 
disappear.

Disposing of your used product

EU-wide legislation as implemented in each Member State requires that used electrical and electronic prod-
ucts carrying the mark (left) must be disposed of separately from normal household waste. This includes 
projectors and their electrical accessories or lamps. When you dispose of such products, please follow the 
guidance of your local authority and/or ask the shop where you purchased the product.
After collecting the used products, they are reused and recycled in a proper way. This effort will help us 
reduce the wastes as well as the negative impact such as mercury contained in a lamp to the human health 
and the environment at the minimum level.
The mark on the electrical and electronic products only applies to the current European Union Member States.
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WARNING TO CALIFORNIA RESIDENTS:
Handling the cables supplied with this product will expose you to lead, a chemical known to the State of California 
to cause birth defects or other reproductive harm. WASH HANDS AFTER HANDLING.

RF Interference (for USA only)

WARNING
The Federal Communications Commission does not allow any modifications or changes to the unit EXCEPT those 
specified by NEC Display Solutions of America, Inc. in this manual. Failure to comply with this government regu-
lation could void your right to operate this equipment. This equipment has been tested and found to comply with 
the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and 
can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, there is no guarantee that interference will not occur in a 
particular installation.
If this equipment does cause harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the 
following measures:

•	 Reorient or relocate the receiving antenna.
•	 Increase the separation between the equipment and receiver.
•	 Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
•	 Consult the dealer or an experienced radio / TV technician for help.

For UK only: In UK, a BS approved power cord with moulded plug has a Black (five Amps) fuse installed for use with 
this equipment. If a power cord is not supplied with this equipment please contact your supplier.

Important Safeguards
These safety instructions are to ensure the long life of your projector and to prevent fire and shock. Please read them 
carefully and heed all warnings.

 Installation
•	 Do not place the projector in the following conditions:

-	 Outdoors
-	 on an unstable cart, stand, or table.
-	 near water, baths, or damp rooms.
-	 in direct sunlight, near heaters, or heat radiating appliances.
-	 in a dusty, smoky or steamy environment. 
-	 on a sheet of paper or cloth, rugs or carpets.

•	 Do not install and store the projector in the below circumstances. Failure to do so may cause of malfunction.
-	 In powerful magnetic fields
-	 In corrosive gas environment

•	 If you wish to have the projector installed on the ceiling:
-	 Do not attempt to install the projector yourself.
-	 The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk 

of bodily injury.
-	 In addition, the ceiling must be strong enough to support the projector and the installation must be in accordance 

with any local building codes.
-	 Please consult your dealer for more information.
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WARNING
•	 Do not place any objects, which are easily affected by heat, in front of the projection window. Doing so could 

lead to the object melting from the heat that is emitted from the light output.

	

•	 Do not use a spray containing flammable gas to get rid of accumulated dust and dirt on the filters and the projection 
window. It may cause of fire.

Place the projector in a horizontal position
The tilt angle of the projector should not exceed 10 degrees, nor should the projector be installed in any way other 
than the desktop and ceiling mount, otherwise lamp life could decrease dramatically.

+10˚

−10˚

 Fire and Shock Precautions 
•	 Ensure that there is sufficient ventilation and that vents are unobstructed to prevent the build-up of heat inside your 

projector. Allow at least 4 inches (10cm) of space between your projector and a wall.
•	 Do not try to touch the exhaust vent as it can become heated while the projector is turned on and immediately after 

the projector is turned off. Parts of the projector may become temporarily heated if the projector is turned off with 
the POWER button or if the AC power supply is disconnected during normal projector operation. 

	 Use caution when picking up the projector.

	

•	 Prevent foreign objects such as paper clips and bits of paper from falling into your projector. Do not attempt to retrieve 
any objects that might fall into your projector. Do not insert any metal objects such as a wire or screwdriver into your 
projector. If something should fall into your projector, disconnect it immediately and have the object removed by a 
qualified service personnel.

•	 Do not place any objects on top of the projector.
•	 Do not touch the power plug during a thunderstorm. Doing so can cause electrical shock or fire.
•	 The projector is designed to operate on a power supply of 100-240V AC 50/60 Hz. Ensure that your power supply 

fits this requirement before attempting to use your projector.
•	 Do not look into the projection window while the projector is on. Serious damage to your eyes could result.

	

•	 Keep any items such as magnifying glass out of the light path of the projector. The light being projected from the 
projection window is extensive, therefore any kind of abnormal objects that can redirect light coming out of the 
projection window, can cause unpredictable outcome such as fire or injury to the eyes.

•	 Do not place any objects, which are easily affected by heat, in front of a projector exhaust vent.
	 Doing so could lead to the object melting or getting your hands burned from the heat that is emitted from the exhaust.
•	 Do not splash water over the projector. Doing so can cause electrical shock or fire. If the projector gets wet, turn off 

the projector, unplug the power cord and have the projector serviced by a qualified service personnel.
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•	 Handle the power cord carefully. A damaged or frayed power cord can cause electric shock or fire.
-	 Do not use any power cord other than the one supplied with the projector.
-	 Do not bend or tug the power cord excessively.
-	 Do not place the power cord under the projector, or any heavy object.
-	 Do not cover the power cord with other soft materials such as rugs.
-	 Do not heat the power cord.
-	 Do not handle the power plug with wet hands.

•	 Turn off the projector, unplug the power cord and have the projector serviced by a qualified service personnel under 
the following conditions:
-	 When the power cord or plug is damaged or frayed.
-	 If liquid has been spilled into the projector, or if it has been exposed to rain or water. 
-	 If the projector does not operate normally when you follow the instructions described in this user’s manual.
-	 If the projector has been dropped or the cabinet has been damaged.
-	 If the projector exhibits a distinct change in performance, indicating a need for service.

•	 Disconnect the power cord and any other cables before carrying the projector.
•	 Turn off the projector and unplug the power cord before cleaning the cabinet or replacing the lamp.
•	 Turn off the projector and unplug the power cord if the projector is not to be used for an extended period of time.
•	 When using a LAN cable (only models with the RJ-45 LAN port):
	 For safety, do not connect to the terminal for peripheral device wiring that might have excessive voltage.

 CAUTION
•	 Be sure to tighten the screws after attaching the cable cover. Failure to do so may cause the cable cover to come 

off and fall, resulting in injury or damage to the cable cover.
•	 Do not put bundled cables in the cable cover. Doing so may damage the power cord, resulting in a fire.
•	 Do not hold the cable cover while moving the projector or do not apply excessive force to the cable cover. Doing 

so may damage the cable cover, resulting in injury.
•	 Do not use the feet for purposes other than originally intended. Misuses such as gripping the tilt-foot or hanging 

on the wall can cause damage to the projector.
•	 Do not send the projector in the soft case by parcel delivery service or cargo shipment. The projector inside the 

soft case could be damaged.
•	 Select [HIGH] in Fan mode if you continue to use the projector for consecutive days. (From the menu, select 

[SETUP] → [OPTIONS(1)] → [FAN MODE] → [HIGH].)
•	 Do not turn off the AC power for 60 seconds after the lamp is turned on and while the POWER indicator is blink-

ing blue. Doing so could cause premature lamp failure.

Remote Control Precautions

•	 Handle the remote control carefully.

•	 If the remote control gets wet, wipe it dry immediately.

•	 Avoid excessive heat and humidity.

•	 Do not short, heat, or take apart batteries.

•	 Do not throw batteries into fire.

•	 If you will not be using the remote control for a long time, remove the batteries.

•	 Ensure that you have the batteries’ polarity (+/−) aligned correctly.

•	 Do not use new and old batteries together, or use different types of batteries together.

•	 Dispose of used batteries according to your local regulations.
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Note for US Residents
The lamp in this product contains mercury. Please dispose according to Local, State or Federal Laws.

Lamp Replacement
•	 Use the specified lamp for safety and performance.
•	 To replace the lamp, follow all instructions provided on page 116.
•	 Be sure to replace the lamp and filter when the message [THE LAMP HAS REACHED THE END OF ITS USABLE 

LIFE. PLEASE REPLACE THE LAMP AND FILTER.] appears. If you continue to use the lamp after the lamp has 
reached the end of its usable life, the lamp bulb may shatter, and pieces of glass may be scattered in the lamp case. 
Do not touch them as the pieces of glass may cause injury.

	 If this happens, contact your dealer for lamp replacement.

A Lamp Characteristic
The projector has a discharge lamp for special purposes as a light source.
A lamp has a characteristic that its brightness gradually decreases with age. Also repeatedly turning the lamp on 
and off will increase the possibility of its lower brightness.
The actual lamp life may vary depending upon the individual lamp, the environmental conditions and usage.

 CAUTION:
•	 DO NOT TOUCH THE LAMP immediately after it has been used. It will be extremely hot. Turn the projector off 

and then disconnect the power cord. Allow at least one hour for the lamp to cool before handling.
•	 When removing the lamp from a ceiling-mounted projector, make sure that no one is under the projector. Glass 

fragments could fall if the lamp has been burned out.

About High Altitude mode

•	 Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 5500 feet/1700 meters 
or higher.

	 Using the projector at altitudes approximately 5500 feet/1700 meters or higher without setting to [HIGH ALTITUDE] 
can cause the projector to overheat and the protector could shut down. If this happens, wait a couple minutes and 
turn on the projector.

•	 Using the projector at altitudes less than approximately 5500 feet/1700 meters and setting to [HIGH ALTITUDE] 
can cause the lamp to overcool, causing the image to flicker. Switch [FAN MODE] to [AUTO].

•	 Using the projector at altitudes approximately 5500 feet/1700 meters or higher can shorten the life of optical com-
ponents such as the lamp.

About Copyright of original projected pictures:
Please note that using this projector for the purpose of commercial gain or the attraction of public attention in a venue 
such as a coffee shop or hotel and employing compression or expansion of the screen image with the following func-
tions may raise concern about the infringement of copyrights which are protected by copyright law.
[ASPECT RATIO], [KEYSTONE], Magnifying feature and other similar features.

Turkish RoHS information relevant for Turkish market
EEE Yonetmeliğine Uygundur.

This device is not intended for use in the direct field of view at visual display workplaces. To avoid incommoding reflec-
tions at visual display workplaces this device must not be placed in the direct field of view.
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Power management function
The projector has power management functions. To reduce power consumption, the power management functions (1 
and 2) are factory preset as shown below. To control the projector from an external device via a LAN or serial cable 
connection, use the on-screen menu to change the settings for 1 and 2.

1.	 STANDBY MODE (Factory preset: NORMAL)

	 To control the projector from an external device, select [NETWORK STANDBY] for [STANDBY MODE].

NOTE:
•	 When [NORMAL] is selected for [STANDBY MODE], the following connectors and functions will not work:
	 MONITOR OUT connector, AUDIO OUT connector, LAN functions, Mail Alert function, DDC/CI (Virtual Remote Tool). Please refer 

to page 67 about details.

2.	 AUTO POWER OFF (Factory preset: 1 hour)

	 To control the projector from an external device, select [OFF] for [AUTO POWER OFF].

NOTE:
•	 When [1:00] is selected for [AUTO POWER OFF], you can enable the projector to automatically turn off in 60 minutes if there is 

no signal received by any input or if no operation is performed.

Cautions on using the stylus pen
•	 Use a flat and hard screen with a screen size of 100 inches or less.
•	 Some screen surfaces can be scratched by the stylus pen tip. Before using the stylus pen, test it in an inconspicuous 

part of the screen to be sure the pen tip will not damage the screen surface.
•	 Do not use the stylus pen in the below mentioned areas.
	 It may cause of malfunction of the stylus pen.

-	 In the area direct sunlight strikes the screen surface and the camera unit.
-	 In the area light of halogen or filament lamps directly strikes the screen surface and the camera unit.
-	 In the case, materials reflects light is used within the stylus pen operation area. (ex. screen frame)

•	 Do not use the stylus pen in the below mentioned environment.  It may cause of malfunction of the stylus pen.
-	 When the infrared remote is used.

Model Number of Wireless LAN unit
Wireless LAN unit is an optional item.
To find the appropriate model to your area, please visit the company website:
URL: http://www.nec-display.com/global/support/index.html

http://www.nec-display.com/global/support/index.html
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1. Introduction
❶ What’s in the Box?
Make sure your box contains everything listed. If any pieces are missing, contact your dealer.
Please save the original box and packing materials if you ever need to ship your projector.

Projector

Cable cover (24FU2001) 
(attached to the projector 
at the time of shipment → 
page 5)

Remote control
(7N901121)

Batteries (AAA × 2)

Power cord
(US: 7N080240/7N080243)
(EU: 7N080027/7N080029)

Computer cable (VGA)
(7N520089)

Wireless receiver strap

Stylus Pen × 2 
(7N901111)

USB cable (for charging a stylus pen) 
(7N520090)

USB cable (5m) 
(7N520091)

For North America only
Limited warranty
For customers in Europe: 
You will find our current valid Guar-
antee Policy on our Web Site: 
www.nec-display-solutions.com•	 Important Infomation (For North 

America: 7N8N5641) (For Other 
countries than North America: 
7N8N5641 and 7N8N5651)

•	 Quick Setup Guide (7N8N5661)/
(7N8N5671)

NEC Projector CD-ROM
User’s manual (PDF) and the utility 
software
(7N952151)

NOTE:
•	 Perform calibration for the stylus pen before using it.
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❷ Introduction to the Projector
This section introduces you to your new projector and describes the features and controls.

Features you’ll enjoy:

•	 Ultra short throw distances 

	 Ultra short focal lenses provide for a larger image using a shorter throw distance when compared to a typical 
projector lens.

	 Max 110", throw distance: 51 cm/20 inches

	 (The throw distance refers to the distance between the screen and the screen side of the projector)

•	 Quick start (6 seconds*1), Quick Power Off, Direct Power Off

	 6 seconds*1 after turning on the power, the projector is ready to display PC or video images.

	 The projector can be put away immediately after the projector is powered down. No cool down period is required 
after the projector is turned off from the remote control or cabinet control panel.

	 The projector has a feature called “Direct Power Off”. This feature allows the projector to be turned off (even when 
projecting an image) by using the Main Power Switch or disconnecting the AC power supply.

	 To turn off the AC power supply when the projector is powered on, use a power strip equipped with a switch and 
a breaker.

*1	 The quick start time is only when [STANDBY MODE] is set to [NETWORK STANDBY] in the on-screen mes-
sage.

•	 0.22 W(100-130 V AC)/0.39 W (200-240 V AC) in standby condition with energy saving technology

	 Selecting [NORMAL] for [STANDBY MODE] from the menu can put the projector in power-saving mode that con-
sumes only 0.22 W(100-130 V AC)/0.39 W (200-240 V AC).

•	 Carbon Meter 

	 This feature will show energy-saving effect in terms of CO2 emission reduction (kg) when the projector’s [ECO 
MODE] is set to [AUTO ECO], [NORMAL], or [ECO].

	 The amount of CO2 emission reduction will be displayed in the confirmation message at the time of power-off and 
in the INFO of the on-screen menu.

•	 Lamp life up to 6000 hours

	 Using in Eco Mode (ECO) allows you to prolong the projector’s lamp life up to 6000 hours (up to 3800 hours in 
ECO MODE OFF). 

•	 Two HDMI inputs supports digital signals

	 The two HDMI inputs provide HDCP compatible digital signals. The HDMI input also supports audio signal.

•	 Project the image on a smart phone and a tablet

	 Since the projector supports MHL (Mobile High-definition Link), it can project videos and photos on a smart phone 
and a tablet terminal by connection, and output their sound from the built-in speaker.

•	 20 W built-in speaker for an integrated audio solution

	 Powerful 20 watt monaural speaker provides volume need for large rooms.

•	 MIC Input provided

	 A MIC input jack for a commercially available dynamic microphone is useful for your presentation in a conference 
room or lecture in a classroom.

•	 The stylus pen supplied with the projector can be used to convert your whiteboard into a virtual touch 
screen.

	 By the stylus pen, it's able to directly write-into the projected image that realizes more effective presentation and 
lecture.
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•	 Correspond to various installation

	 Besides installation on the wall, it can correspond various installation as projecting image up onto the ceiling , onto 
the table, and onto the floor, etc.

•	 The supplied remote control allows you to assign a CONTROL ID to the projector

	 Multiple projectors can be operated separately and independently with the same single remote control by assigning 
an ID number to each projector.

•	 USB Display 

	 Using the USB cable (compatible with USB 2.0 specifications) supplied with the projector to connect the computer 
with the projector allows you to send your computer screen image to the projector without the need of a traditional 
computer cable (VGA).

•	 Integrated RJ-45 terminal for wired networking capability along with wireless networking capabilities

	 An RJ-45 terminal is standard. An optional USB Wireless LAN Unit is required for wireless LAN connection.

•	 Software programs (User Supportware) contained in the supplied CD-ROM

	 The supplied NEC Projector includes three programs: Virtual Remote Tool, Image Express Utility Lite (for Windows/
Mac OS), and PC Control Utility Pro 4 (for Windows)/5 (for Mac OS).

	 Image Express Utility Lite (for Windows) can be started from a commercially available USB memory or SD card 
without the need of installing on your computer.

•	 AUTO POWER ON and AUTO POWER OFF features

	 The DIRECT POWER ON, AUTO POWER ON, AUTO POWER OFF, and OFF TIMER features eliminate the need 
to always use the POWER button on the remote control or projector cabinet.

•	 Preventing unauthorized use of the projector

	 Enhanced smart security settings for keyword protection, cabinet control panel lock, security slot, and security 
chain opening to help prevent unauthorized access, adjustments and theft deterrence.

•	 High resolution up to WUXGA*2

	 High resolution display - up to WUXGA compatible, WXGA native resolution.

*2	 When WXGA MODE is set to ON.

•	 CRESTRON ROOMVIEW compatibility

	 The projector supports CRESTRON ROOMVIEW, allowing multiple devices connected in the network to be man-
aged and controlled from a computer or controller.

About this user’s manual
The fastest way to get started is to take your time and do everything right the first time. Take a few minutes now to 
review the user’s manual. This may save you time later on. At the beginning of each section of the manual you’ll find 
an overview. If the section doesn’t apply, you can skip it.
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1. Introduction

❸ Part Names of the Projector
Top and Screen Side of Projector

Controls
(→ page 7)

Filter Cover/Intake Vent/Filter
(→ page 112, 119)

Camera 
For utilizing the Whiteboard func-

tion, photograph the screen for 
detecting the stylus pen position.

Focus Ring
(→ page 18)

Tilt Foot
(→ page 19)

Built-in Security Slot (  )*

Lamp Cover
(→ page 117)

Security chain opening 
Attach an anti-theft device.
The security chain opening accepts 
security wires or chains up to 0.18 
inch/4.6 mm in diameter.

*	 This security slot supports the 
MicroSaver® Security System.

Monaural Speaker (20 W)

Terminal Panel (→ page 8)

AC Input
Connect the supplied power cord’s 

three-pin plug here, and plug the 
other end into an active wall outlet. 

(→ page 13)

Remote Sensor
(→ page 10)

Screw Hole for Cable Cover (Left/
Right)
(→ page 6)

Terminal Panel Side of Projector

Intake Vent/Filter
(→ page 112, 119)

Exhaust Vent

Projection Window
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1. Introduction

Removing and Attaching the Cable Cover
After finishing connections, attach the supplied cable cover to properly hide the cables.

 CAUTION:
•	 Be sure to tighten the screws after attaching the cable cover. Failure to do so may cause the cable cover to come 

off and fall, resulting in injury or damage to the cable cover.
•	 Do not put bundled cables in the cable cover. Doing so may damage the power cord, resulting in a fire.
•	 Do not hold the cable cover while moving the projector or do not apply excessive force to the cable cover. Doing so 

may damage the cable cover, resulting in injury.

Removing the cable cover

Tool needed:
•	 Phillips screwdriver (plus-head) about 9 cm/4 inches in length

9 cm/4 inches

1.	 Loosen the cable cover screws until the Phillips screw-
driver goes into a freewheeling condition.

	 • These screws remain to stay.

2.	 Remove the cable cover. 

❶	Push up the cable cover slightly and rotate it to release.

❷	Pull the cable cover while pushing and holding the arrow 
part 

	 If you find it to hard to release the cable cover, try holding it 
slightly up.

1

2
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1. Introduction

Attaching the cable cover

1.	 Align four tabs of the cable cover with grooves of the pro-
jector and push the cable cover until you click it.

NOTE:
•	 Be careful not to get cables caught in between the cable cover and 

the projector.

2.	 Tighten the cable cover screws.

•	 Be sure to tighten the screws.
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1. Introduction

Top Features

1, 2

7

4 8

9

11

5

6

10

3

1.	  (POWER) Button 
	 (→ page 14, 24)

2.	 POWER Indicator 
	 (→ page 13, 14, 24, 122)

3.	 STATUS Indicator 
	 (→ page 122)

4.	 LAMP Indicator 
	 (→ page 116, 122)

5.	 ECO Button 
	 (→ page 29)

6.	 SOURCE Button 
	 (→ page 16)

7.	 AUTO ADJ. Button 
	 (→ page 23)

8.	 MENU Button 
	 (→ page 44)

9.	 ▲▼◀▶ / Volume Buttons ◀▶ / Keystone Buttons 
	 (→ page 15, 21, 23, 44)

10.	ENTER Button 
	 (→ page 44)

11.	EXIT Button 
	 (→ page 44)
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1. Introduction

Terminal Panel Features

1.	 COMPUTER IN/ Component Input Terminal (Mini 
D-Sub 15 Pin) 

	 (→ page 77, 81, 84)

2.	 COMPUTER AUDIO IN Mini Jack (Stereo Mini) 
	 (→ page 77, 78, 81)

3.	 HDMI 1/MHL IN Terminal (Type A) 
	 (→ page 77, 78, 82, 83)

4.	 HDMI 2 IN Terminal (Type A) 
	 (→ page 77, 78, 82)

5.	 USB (PC) Port (Type B) 
	 (→ page 39, 40, 77)

6.	 MONITOR OUT (COMPUTER) Terminal (Mini D-
Sub 15 Pin) 

	 (→ page 109)

7.	 AUDIO OUT Mini Jack (Stereo Mini) 
	 (→ page 109)

8.	 VIDEO IN Terminal (RCA) 
	 (→ page 80, 114)

9.	 VIDEO/S-VIDEO AUDIO IN L/MONO, R (RCA) 
	 (→ page 80)

10.	MIC Input Jack (Monaural Mini)
	 (→ page 38)

11.	LAN Port (RJ-45) 
	 (→ page 85)

12.	USB (Wireless LAN) Port 
	 (→ page 86)

13.	USB Port (Type A) 
	 (→ page 89)

14.	PC CONTROL [PC CONTROL] Port (D-Sub 9 Pin) 
	 (→ page 132)
	 Use this port to connect a PC or control system. 

This enables you to control the projector using serial 
communication protocol. If you are writing your own 
program, typical PC control codes are on page 132.

1

2

45

7

6 9

14

8 10

111312 3
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1. Introduction

❹ Part Names of the Remote Control

＋

3
4
6
7

1

2

10
16

17
15
14

9

5
8

13

30

31
32

20
21
26
28

29
2524

23
22

27

33

19
18

12
11

1.	 Infrared Transmitter
	 (→ page 10)

2.	 POWER ON Button
	 (→ page 14)

3.	 POWER STANDBY Button
	 (→ page 24)

4.	 SOURCE Button
	 (→ page 16)

5.	 COMPUTER 1 Button
	 (→ page 16)

6.	 COMPUTER 2 Button
	 (This button does not work in this 

series of projectors)

7.	 AUTO ADJ. Button
	 (→ page 23)

8.	 HDMI 1/MHL Button
	 (→ page 16)

9.	 HDMI 2 Button
	 (→ page 16)

10.	DisplayPort Button
	 (This button does not work in this 

series of projectors) 

11.	VIDEO Button 
	 (→ page 16)

12.	HDBaseT Button 
	 (This button does not work in this 

series of projectors)

13.	USB-B Button 
	 (→ page 16, 77)

14.	APPS Button 
	 (→ page 16, 88)

15.	ID SET Button
	 (→ page 63)

16.	Numeric Keypad Button/
CLEAR Button

	 (→ page 64)

17.	FREEZE Button
	 (→ page 26)

18.	AV-MUTE Button
	 (→ page 26)

19.	MENU Button
	 (→ page 44)

20.	EXIT Button 
	 (→ page 44)

21.	▲▼◀▶ Button 
	 (→ page 44)

22.	ENTER Button 
	 (→ page 44)

23.	D-ZOOM (+)(–) Button
	 (→ page 28)

24.	MOUSE L-CLICK Button*
	 (→ page 39)

25.	MOUSE R-CLICK Button*
	 (→ page 39)

26.	PAGE ▽/△ Button
	 (→ page 39)

27.	ECO Button 
	 (→ page 29)

28.	KEYSTONE Button
	 (→ page 31)

29.	PICTURE Button
	 (→ page 50, 52)

30.	VOL. (+)(–) Button
	 (→ page 23)

31.	ASPECT Button
	 (→ page 55)

32.	FOCUS/ZOOM Button
	 The ZOOM button will display the 

DIGITAL ZOOM bar. 
	 (→ page 20, 58)
	 The FOCUS button does not work 

on this series of projectors.

33.	HELP Button
	 (→ page 70)

*	 The MOUSE L-CLICK and MOUSE R-CLICK buttons work only when a USB cable is connected with your computer.
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1. Introduction

Remote Control Precautions
•	 Handle the remote control carefully.
•	 If the remote control gets wet, wipe it dry immediately.
•	 Avoid excessive heat and humidity.
•	 Do not short, heat, or take apart batteries.
•	 Do not throw batteries into fire.
•	 If you will not be using the remote control for a long time, remove the batteries.
•	 Ensure that you have the batteries’ polarity (+/−) aligned correctly.
•	 Do not use new and old batteries together, or use different types of batteries together.
•	 Dispose of used batteries according to your local regulations.

Operating Range for Wireless Remote Control

30°
30°

30°

30°

60°

22
 fe

et
/7

 m

19.7 feet/6 m

Remote sensor on projector cabinet

Remote sensor on projector cabinet

Remote control

Remote control

•	 The infrared signal operates by line-of-sight up to a distance of about 22 feet/7 m and within a 60-degree angle of 
the remote sensor on the projector cabinet.

•	 The projector will not respond if there are objects between the remote control and the sensor, or if strong light falls 
on the sensor. Weak batteries will also prevent the remote control from properly operating the projector.

1 Press firmly and slide the battery 
cover off.

2 Install new batteries (AAA). Ensure 
that you have the batteries’ polarity 
(+/−) aligned correctly.

Battery Installation

3 Slip the cover back over the bat-
teries until it snaps into place. Do 
not mix different types of batteries 
or new and old batteries.

OP
EN

OP
EN
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1. Introduction

❺ Part names of the supplied stylus pen

Indicator (LED)

Charging port (USB)

Pen tip

Charging the stylus pen
1.	 Use the supplied USB cable for charging the stylus pen to connect the charging port (USB) of the stylus 

pen with the USB port of the computer.

2.	 Automatically start charging the stylus pen. It takes about 3 minutes to complete.

•	 Pressing the pen tip against a screen or white board will turn the indicator LED to red, which indicates that 
charging is completed and you are ready to use the stylus pen.

•	 If the red LED turns off, charge the stylus pen.

Cautions on using the stylus pen
•	 Do not damage the stylus pen by dropping it on the floor or mishandling it.
•	 Keep the stylus pen away from water and other liquids. If the stylus pen gets wet, wipe the stylus pen dry immediately.
•	 Avoid heat and humidity as much as possible.
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This section describes how to turn on the projector and to project a picture onto the screen.

❶ Flow of Projecting an Image

Step 1
•	 Connecting your computer / Connecting the power cord (→ page 13)

	

Step 2 
•	 Turning on the projector (→ page 14)

	

Step 3 
•	 Selecting a source (→ page 16)

	

Step 4
•	 Adjusting the picture size and position (→ page 17)

•	 Correcting keystone distortion [KEYSTONE] (→ page 21)

	

Step 5
•	 Adjusting a picture and sound

-	 Optimizing a computer signal automatically (→ page 23)

-	 Turning up or down volume (→ page 23)

	

Step 6
•	 Making a presentation

	

Step 7
•	 Turning off the projector (→ page 24)

	

Step 8
•	 When Moving the Projector (→ page 25)

2. Projecting an Image (Basic Operation)
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2. Projecting an Image (Basic Operation)

❷ Connecting Your Computer/Connecting the Power Cord

1.	 Connect your computer to the projector.

	 This section will show you a basic connection to a computer. For information about other connections, see “5. 
Installation and Connections” on page 77.

	 Connect the computer cable (VGA) between the projector’s COMPUTER IN terminal and the computer’s port (mini 
D-Sub 15 Pin). Turn two thumb screws of both terminals to fix the computer cable (VGA).

2.	 Connect the supplied power cord to the projector.

	 First connect the supplied power cord’s three-pin plug to the AC IN of the projector, and then connect the other 
plug of the supplied power cord in the wall outlet.

	 The projector’s power indicator will flash for a few seconds and then will light red* (standby mode).

*	 This will apply for both indicators when [NORMAL] is selected for [STANDBY MODE]. See the Power Indicator 
section.(→ page 122) 

Make sure that the prongs are fully inserted into 
both the AC IN and the wall outlet.

To wall outlet ←

 CAUTION:
Parts of the projector may become temporarily heated if the projector is turned off with the POWER button or if the 
AC power supply is disconnected during normal projector operation.
Be careful to handle the projector.
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2. Projecting an Image (Basic Operation)

❸ Turning on the Projector

•	 Press the  (POWER) button on the projector cabinet 
or the POWER ON button on the remote control. 

	 The POWER indicator will blink and the projector will be-
come ready to use.

TIP: 
•	 When the message “Projector is locked! Enter your password.” 

is displayed, it means that the [SECURITY] feature is turned on. 
(→ page 35)

	 After you turn on your projector, ensure that the computer 
or video source is turned on.

NOTE: When no input signal is present, the no-signal guidance is 
displayed (factory menu setting).

(→ page 122)

Standby Blinking Power On

Steady red light Blinking blue light Steady blue light
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2. Projecting an Image (Basic Operation)

Note on Startup screen (Menu Language Select screen)
When you first turn on the projector, you will get the Startup menu. This menu gives you the opportunity to select one 
of the 30 menu languages.

To select a menu language, follow these steps:

1.	 Use the ▲, ▼, ◀ or ▶ button to select one of the 30 
languages from the menu.

2.	 Press the ENTER button to execute the selection.

After this has been done, you can proceed to the menu 
operation.
If you want, you can select the menu language later.
(→ [LANGUAGE] on page 46 and 59)

NOTE: 
•	 If the projector is shut off by DIRECT POWER OFF (pulling out the power cord) during projection, wait for 1 second at least for 

reconnect the power cord for turning on the projector.
	 Failing to do so could result in no power to the projector. (There will be no stand-by LED) 
	 Should this happen, unplug the power cord and plug it in again. Turn on the main power.
•	 If one of the following things happens, the projector will not turn on.

-	 If the internal temperature of the projector is too high, the projector detects abnormal high temperature. In this condition the 
projector will not turn on to protect the internal system. If this happens, wait for the projector’s internal components to cool 
down.

-	 When the lamp reaches its end of usable life, the projector will not turn on. If this happens, replace the lamp.
-	 If the STATUS indicator lights orange with the power button pressed, it means that the [CONTROL PANEL LOCK] is turned on. 

Cancel the lock by turning it off. (→ page 62)
-	 If the lamp fails to light, and if the STATUS indicator flashes on and off in a cycle of six times, wait a full minute and then turn 

on the power.
•	 While the POWER indicator is blinking blue in short cycles, the power cannot be turned off by using the power button.
•	 Immediately after turning on the projector, screen flicker may occur. This is normal. Wait 3 to 5 minutes until the lamp lighting is 

stabilized.
•	 When the projector is turned on, it may take some time before the lamp light becomes bright.
•	 If you turn on the projector immediately after the lamp is turned off or when the lamp temperature is high, the fans run without 

displaying an image for some time and then the projector will display the image.
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2. Projecting an Image (Basic Operation)

❹ Selecting a Source
Selecting the computer or video source
NOTE: Turn on the computer or video source equipment connected to the projector.

Detecting the Signal Automatically
Press the SOURCE button once. The projector will search for the avail-
able input source and display it. The input source will change as follows: 

COMPUTER → HDMI1/MHL → HDMI2 → VIDEO → USB-B → APPS

•	 With the SOURCE screen displayed, you can press the SOURCE 
button a few times to select the input source.

TIP: If no input signal is present, the input will be skipped.

Using the Remote Control
Press any one of the COMPUTER 1, HDMI1/MHL, HDMI2, VIDEO, USB-
B, or APPS buttons.

Selecting Default Source
You can so that it will be displayed each time the projector is turned on.
1.	 Press the MENU button.

	 The menu will be displayed.

2.	 Press the ▶ button twice to select [SETUP] and the ▼ button or 
the ENTER button to select [GENERAL].

3.	 Press the ▶ button four times to select [OPTIONS(2)].

4.	 Press the ▼ button five times to select [DEFAULT SOURCE SE-
LECT] and press the ENTER button.

	 The [DEFAULT SOURCE SELECT] screen will be displayed.

	 (→ page 69)

5.	 Select a source as the default source, and press the ENTER button.

6.	 Press the EXIT button a few times to close the menu.

7.	 Restart the projector.

	 The source you selected in step 5 will be projected.

TIP: 
•	 When the projector is in Standby mode, applying a computer signal from a 

computer connected to the COMPUTER IN input will power on the projector 
and simultaneously project the computer’s image.

	 ([AUTO POWER ON] → page 68)
•	 On Windows 7, a combination of the Windows and P keys allows you to set up 

external display easily and quickly.
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2. Projecting an Image (Basic Operation)

❺ Adjusting the Picture Size and Position
Use the adjustable tilt foot, the zoom function or the focus ring to adjust the picture size and position.
In this chapter drawings and cables are omitted for clarity.

Adjusting horizontal/vertical position
(→ page 18)

Adjusting the focus [Focus ring]
(→ page 18)

Finely adjusting the left and right tilt [Tilt Foot]
(→ page 19)

Adjusting the size [Digital Zoom]
(→ page 20)

Correcting the keystone distortion [Keystone]*
(→ page 21)

*	 To perform keystone correction manually, see “6. Correcting Keystone Distortion [KEYSTONE]” on page 21.
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2. Projecting an Image (Basic Operation)

Adjusting horizontal/vertical position
The throw distance can affect the size and the height of the projected image. Before installing the projector, decide 
the throw distance according to “Setting Up the Screen and the Projector” (→ page 75)
It is recommended to display the test pattern while adjusting the image. (→ page 64) 

1.	 Move the projector back and forth and left and right so that 
the image fits the screen width.

	 You can reduce the image size to 70% by using [DIGITAL ZOOM] 
from the menu.

2.	 Place the projector so that it is parallel with the screen.

	 If the top side of the image is not parallel with its bottom side, rotate 
the projector slightly to adjust it. If the side of the image shows 
outside the screen, move it to the center line of the screen.

Adjusting the focus (Focus ring)

•	 Rotate the focus ring until you obtain the best focus.

Focus ring
(view from the bottom)
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2. Projecting an Image (Basic Operation)

Adjusting the tilt (Tilt foot)
Adjusting the left and right tilt.

1.	 Rotate the tilt foot to adjust the left and right tilt.

	 The tilt foot is equipped at the left and the right front bottom of the 
projector.

	 If the projected image is tilted, rotate one of the tilt foot to adjust 
the angle to project. 

	 If keystone distortion is appeared, adjust it either by the ▼ button 
on the cabinet or keystone button on the remote control

NOTE:
•	 Do not extend the tilt foot beyond its height limit (18 mm/0.7 inches). Doing 

so may cause the tilt foot to come out of the projector.
•	 Do not use the tilt-foot for purposes other than originally intended. 
	 Misuses such as using the tilt foot to carry or hang (from the wall or ceiling) 

the projector can cause damage to the projector.

Up

Down
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2. Projecting an Image (Basic Operation)

Adjusting the size [Digital Zoom]
Use the remote control to finely adjust the size of the image.

1.	 Press the FOCUS/ZOOM button on the remote control.

	 The DIGITAL ZOOM bar will be displayed.

2.	 Press the ◀ or ▶ button to finely zoom in or out.

3.	 After completing the adjustment, press the ENTER button. 

	 The DIGITAL ZOOM bar will be closed.

NOTE:
•	 This feature allows you to electronically fine adjust the image size on the 

screen
•	 This feature can not be used when [USB-B] is selected as a input terminal.
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2. Projecting an Image (Basic Operation)

❻ Correcting Keystone Distortion [KEYSTONE]
When the projector is not exactly perpendicular to the screen, keystone distortion occurs. To overcome it, you can use the 
“Keystone” function, a digital technology that can adjust for keystone-type distortion, resulting in a crisp, square image.
The following procedure explains how to use the [KEYSTONE] screen from the menu to correct trapezoidal distortions.
When the projector is placed diagonally to the screen, 
When the projector is set up at an angle in relation to the screen, adjust the Horizontal option of the Keystone menu 
so that the top and bottom of sides of the projected image are parallel.

1.	 When APPS is not selected as source and the menu is not dis-
played on, press the ▼ button on the projector cabinet.

	 The Keystone screen will be displayed on the screen.

•	 Press the KEYSTONE button when using the remote control.

•	 See page for PINCUSHION.

•	 See page for CORNERSTONE.

•	 See page for RESET.

2.	 Press the ▼ button to select [KEYSTONE VERTICAL] and then use 
the ◀ or ▶ so that the left and right sides of the projected image 
are parallel.

*	 Adjust the vertical keystone distortion.

Projected area
Screen frame

3.	 Align the left (or right) side of the screen with the left (or right) 
side of the projected image.

•	 Use the shorter side of the projected image as the base.

•	 In the right example, use the left side as the base.

Align left side
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2. Projecting an Image (Basic Operation)

4.	 Press the ▲ button to select [KEYSTONE HORIZONTAL] and then 
use the ◀ or ▶ so that the top and bottom sides of the projected 
image are parallel.

•	 Adjust the horizontal keystone distortion.

5.	 Repeat steps 2 and 4 to correct keystone distortion.

6.	 After completing Keystone correction, press the EXIT button.

	 The Keystone screen will disappear.

•	 To perform Keystone correction again, press the ▼ button to display 
the Keystone screen and repeat above steps 1 to 6.

To return the keystone adjustments to default:
1.	 Press the ▼ button to select [RESET] and press the ENTER button.

2.	 Press the ◀ or ▶ button to select [YES] and press the ENTER button.

	 The adjustments will be reset.

	 All the adjustments for all the five items will be reset at the same time.

•	 The KEYSTONE feature can cause an image to be slightly blurred because the correction is made electronically.
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2. Projecting an Image (Basic Operation)

❼ Optimizing Computer Signal Automatically
Adjusting the Image Using Auto Adjust
Optimizing a computer image automatically. (COMPUTER)
Press the AUTO ADJ. button to optimize a computer image automatically.
This adjustment may be necessary when you connect your computer for the first time.

[Poor picture]

[Normal picture]

NOTE:
Some signals may take time to display or may not be displayed correctly.
•	 If the Auto Adjust operation cannot optimize the computer signal, try to adjust [HORIZONTAL], [VERTICAL], [CLOCK], and [PHASE] 

manually. (→ page 53, 54)

❽ Turning Up or Down Volume
Sound level from the speaker or audio output can be adjusted.

TIP: When no menus appear, the ◀ and ▶ buttons on the projector cabinet work 
as a volume control. 

NOTE:
•	 Volume control is not available with the ◀ or ▶ button when an image is magni-

fied by using the D-ZOOM (+) button, when the menu is displayed, or when the 
APPS is displayed.

TIP: The [BEEP] sound volume cannot be adjusted. To turn off the [BEEP] sound, 
from the menu, select [SETUP] → [OPTIONS (1)] → [BEEP] → [OFF].

Increase volume

Decrease volume
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2. Projecting an Image (Basic Operation)

❾ Turning off the Projector
To turn off the projector:

1.	 First, press the  (POWER) button on the projector 
cabinet or the STANDBY button on the remote control. 

	 The confirmation message will be displayed.

2.	 Secondly, press the ENTER button or press the  
(POWER) or the STANDBY button again.

	 The lamp will turn off and the projector will go into standby 
mode. When in standby mode, the POWER indicator will 
light red and the STATUS indicator will turn off when [NOR-
MAL] is selected for [STANDBY MODE]. 

 CAUTION:
Parts of the projector may become temporarily heated if the projector is turned off with the POWER button or if the 
AC power supply is disconnected during normal projector operation.
Use caution when picking up the projector.

NOTE:
•	 While the power indicator is blinking blue in short cycles, the power cannot be turned off.
•	 You cannot turn off the power for 60 seconds immediately after turning it on and displaying an image.
•	 Do not disconnect the AC power supply to the projector within 10 seconds of making adjustment or setting changes and closing 

the menu. Doing so can cause loss of adjustments and settings.

Power On

Steady blue light

Standby

Steady red light
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2. Projecting an Image (Basic Operation)

❿ When Moving the Projector
Preparation: Make sure that the projector is turned off.

1.	 Remove the cable cover.

	 (→ page 5)

2.	 Unplug the power cord.

3.	 Disconnect any other cables.

•	 Remove the USB memory or the wireless LAN Unit if it is inserted into the projector.

	 (→ page 86)
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❶ Turning off the Image and Sound
Press the AV-MUTE button to turn off the image and sound for a short 
period of time. Press again to restore the image and sound.
The projector’s power-saving function will work 10 seconds after the 
image is turned off.
As a result, the lamp power will be reduced.

NOTE:
•	 Even though the image is turned off, the menu still remains on the screen.
•	 Sound from the AUDIO OUT jack (Stereo mini) can be turned off.
•	 Even when the power-saving function works, the lamp power may be restored to its original level temporarily.
•	 To restore the image, even if you press the AV-MUTE button immediately after the start of the power-saving function, the lamp 

brightness may not be restored to its original level.

❷ Freezing a Picture/Screen Capture
Once the FREEZE button is pressed, the Screen Capture menu is 
indicated at the left bottom of the screen.(→ next page)

NOTE: The image is frozen but the original video is still playing back.

3. Convenient Features
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3. Convenient Features

Saving the projected screen images temporarily on the build-in memory/Screen Capture
Once the FREEZE button is pressed, the Screen Capture menu is indicated at the left bottom of the screen. If no 
operation is performed for 3 seconds, the menu will disappear and a picture will freeze.

CAPTURE & INTERACTIVE WHITEBOARD
Capture the projected screen image and boot up the inter-
active whiteboard.

FREEZE
A picture will freeze by press. Press again to resume mo-
tion.

CAPTURE
Temporarily save the projected screen image 
on the projector’s built-in memory. The built-
in memory is called “the Projector Memory”.

FOCUS
Shows the current selection that is surrounded by yellow 
lines. Use ◀ or ▶ button for moving to other options.

•	 It is possible to call out the captured display screen utilizing the VIEWER in the APPS MENU or the web-sharing 
function. Moreover, the web-sharing function enables to save the captured screen image onto terminals as a com-
puter and a smart phone that are connected by the network.

•	 You may not select the CAPTURE icon depending on the input terminals or signals. In the below conditions, you 
cannot select the CAPTURE icon.
•	 When the VIDEO-IN is selected as the input terminal and the input signal has contents protection.
•	 When the HDMI/MHL is selected as the input terminal and the input signal has contents protection (HDCP).
•	 During playing the motion picture thru the VIEWER.
•	 When the Miracast is selected from the APPS MENU.

•	 The format of the captured screen image is as follows:
•	 Format: JPEG
•	 Resolution: 1280 × 800 dots (Panel resolution of the projector)
•	 File prepared date and time: Date and time set on the projector

NOTE:
•	 The captured pictures will be deleted from the projector memory when the projector is turned off.
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3. Convenient Features

❸ Magnifying a Picture
You can enlarge the picture up to four times.

NOTE:
•	 The maximum magnification may be less than four times depending on the signal.
•	 This feature can not be used when [USB-B] is selected as the input terminal.

To do so:

1.	 Press the D-ZOOM (+) button to magnify the picture.

	 To move the magnified image, use the ▲,▼,◀ or ▶ button.

2.	 Press the ▲▼◀▶ button.
	 The area of the magnified image will be moved

3.	 Press the D-ZOOM (−) button.

	 Each time the D-ZOOM (−) button is pressed, the image is reduced.

NOTE: 
•	 The image will be magnified or demagnified at the center of the screen.
•	 Displaying the menu will cancel the current magnification.
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❹ Changing Eco Mode/Checking Energy-Saving Effect 
Using Eco Mode [ECO MODE]
The ECO MODE (NORMAL and ECO) increases lamp life, while lowering power consumption and cutting down on 
CO2 emissions. 
Four brightness modes of the lamp can be selected: [OFF], [AUTO ECO], [NORMAL] and [ECO] modes. 

[ECO MODE] Description Status of LAMP indicator

[OFF] The lamp brightness is 100%. Off

[AUTO ECO] Lamp power consumption will be changed between 
[OFF] and [NORMAL] automatically according to 
picture level
NOTE: A bright gradation may be less visible depending 
on the image.

[NORMAL] Lamp power consumption: approx.80% brightness. 
The lamp life will extend by lowering the lamp power. 

Steady Green 
light

[ECO] Lamp power consumption (approx. 60% brightness). 
The lamp life will extend longer than the one on 
NORMAL mode by controlling power appropriate for 
the lamp. The maximum power becomes equivalent 
to the power in NORMAL.

To turn on the [ECO MODE], do the following: 
1.	 Press the ECO Button on the remote control to display [ECO MODE] screen.

2.	 Press the ECO button again to select a mode you wish. 

•	 Each time the ECO button is pressed, the choices will be changed:

	 OFF → AUTO ECO → NORMAL → ECO → OFF

TIP: 
•	 The leaf symbol at the bottom of the menu shows the current selection of ECO mode.

NOTE: 
•	 The [ECO MODE] can be changed by using the menu.
	 Select [SETUP] → [GENERAL] → [ECO MODE].
•	 The lamp life remaining and lamp hours used can be checked in [USAGE TIME]. Select [INFO.] →[USAGE TIME].
•	 The projector is always in [NORMAL] for 90 seconds after the lamp is turned on and while the POWER indicator is blinking green. 

The lamp condition will not be affected even when [ECO MODE] is changed.
•	 After a lapse of 1 minute from when the projector displays no-signal guidance, a blue, black or logo screen, [ECO MODE] will 

automatically switch to [ECO]. The projector will return to its original setting once a signal is accepted.
•	 If the projector is overheated in [OFF] mode, there may be a case where the [ECO MODE] automatically changes to [NORMAL] 

mode to protect the projector. When the projector is in [NORMAL] mode, the picture brightness decreases. When the projector 
comes back to normal temperature, the [ECO MODE] returns to its original setting.

	 Thermometer symbol [  ] indicates the [ECO MODE] is automatically set to [NORMAL] mode because the internal temperature 
is too high.

•	 Immediately after [ECO MODE] is changed from [ECO] to one of [OFF], [AUTO ECO], or [NORMAL], the lamp brightness may 
decrease temporarily. This is not a malfunction.
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Checking Energy-Saving Effect [CARBON METER]
This feature will show energy-saving effect in terms of CO2 emission reduction (kg) when the projector’s [ECO MODE] 
is set to [AUTO ECO], [NORMAL], or [ECO]. This feature is called as [CARBON METER].

There are two messages: [TOTAL CARBON SAVINGS] and [CARBON SAVINGS-SESSION]. The [TOTAL CARBON 
SAVINGS] message shows the total amount of CO2 emission reduction from the time of shipment up to now. You can 
check the information on [USAGE TIME] from [INFO.] of the menu. (→ page 70)

The [CARBON SAVINGS-SESSION] message shows the amount of CO2 emission reduction between the time of 
changing to ECO MODE immediately after the time of power-on and the time of power-off. The [CARBON SAVINGS-
SESSION] message will be displayed in the [POWER OFF/ ARE YOU SURE?] message at the time of power-off.

TIP:
•	 The formula as shown below is used to calculate the amount of CO2 emission reduction.
	 Amount of CO2 emission reduction = (Power consumption in OFF for ECO MODE − Power consumption in AUTO ECO/NORMAL/

ECO for ECO MODE) × CO2 conversion factor.* When the image is turned off with the AV-MUTE button, the amount of CO2 em-
mission reduction will also increase.

	 * �Calculation for amount of CO2 emission reduction is based on an OECD publication “CO2 Emissions from Fuel Combustion, 2008 
Edition”.

•	 The [TOTAL CARBON SAVINGS] is calculated based on savings recorded in 15 minutes intervals.
•	 This formula will not apply to the power consumption which is not affected by whether [ECO MODE] is turned on or off.
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❺ Using 4-Point Corner to Correct Keystone Distortion 
[CORNERSTONE]

Use the [KEYSTONE HORIZONTAL], [KEYSTONE VERTICAL] (able to correct simultaneously), [CORNERSTONE] 
and [PINCUSHION] to correct keystone distortion.

Cornerstone
1.	 When APPS is not selected as source and the menu is not displayed on, press the KEYSTONE button on 

the remote.

	 The KEYSTONE screen will be displayed.

•	 Press the KEYSTONE button when using the remote control.

•	 See page for PINCUSHION.

2.	 Press the ▼ button to select [CORNERSTONE] and press the ENTER button.

The drawing shows the upper left icon ( ) is selected.

	 The CORNERSTONE screen will be displayed.

3.	 Project an image so that the screen is smaller than the area of the raster.

4.	 Pick up any one of the corners and align the corner of the image with a corner of the screen.

Projected image

The drawing shows the upper right corner.

TIP: If you are adjusting [KEYSTONE HORIZONTAL], [KEYSTONE VERTICAL], or [PINCUSHION], the [CORNERSTONE] item will 
not be available. If this happens, reset the [KEYSTONE] adjustments.

5.	 Use the ▲▼◀▶ button to select one icon (▲) which points in the direction you wish to move the projected 
image frame.

6.	 Press the ENTER button.
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7.	 Use the ▲▼◀▶ button to move the projected image frame as shown on the example.

8.	 Press the ENTER button.

9.	 Use the ▲▼◀▶ button to select another icon which points in the direction.

	 On the Cornerstone adjustment screen, select [EXIT] or press the EXIT button on the remote control.

	 The confirmation screen is displayed.

10.	Press the ◀ or ▶ button to highlight the [OK] and press the ENTER button.

This completes the Cornerstone correction.
Selecting [CANCEL] will return to the adjustment screen without saving changes (Step 3).
Selecting [RESET] will return to the factory default.
Selecting [UNDO] will exit without saving changes.
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Pincushion
1.	 Press the KEYSTONE button with no menu displayed.

	 The KEYSTONE screen will be displayed.

•	 Press the KEYSTONE button when using the remote control.

2.	 Press the ▼ button to select [PINCUSHION] and then press 
the ENTER.

3.	 Press either ▲ or ▼ button to select one from top, bottom, left, 
right, and then press either ◀ or ▶ button to reform pincushion 
distortion.

NOTE:
•	 Once a side is reformed, it disables reforming remaining three sides.
•	 For changing the side to be reformed, set back the reform value of the 

side under reforming to “0”.

4.	 Using ▲ or ▼ buttons and select the reference point, and then 
move the peak point of curved side for reforming using the ◀ 
or ▶ buttons.

5.	 Press the EXIT when PINCUSHION adjustment is completed.

NOTE: 
•	 Even when the projector is turned on, the last used correction values are applied.
•	 [PINCUSHION] and [CORNERSTONE] corrections can cause the image to be slightly blurred because the correction is made 

electronically.
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Reset the keystone and pincushion adjustment to the initial value

1.	 Press the KEYSTONE button with no menu displayed.

	 ON the displayed KEYSTONE menu, set the cursor at RESET using the ▼ button and press ENTER button.

•	 Confirmation message is displayed on.

2.	 Move the cursor onto YES using either ◀ or ▶ button and then press the ENTER.

NOTE:
•	 All adjusted values set in the KEYSTONE adjustment are reset to initial values

TIP:
Adjustable range of the KEYSTONE and the CORNERSTONE:

Horizontal Direction Vertical Direction
CORNERSTONE

Approx. ±10° (Max) Approx. ±10° (Max)
KEYSTONE

Adjustable range may be narrower depending on input signal.
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❻ Preventing the Unauthorized Use of the Projector [SECURITY]
A keyword can be set for your projector using the Menu to avoid operation by an unauthorized user. When a keyword 
is set, turning on the projector will display the Keyword input screen. Unless the correct keyword is entered, the pro-
jector cannot project an image. 
•	 The [SECURITY] setting cannot be cancelled by using the [RESET] of the menu.

To enable the Security function:

1.	 Press the MENU button.

	 The menu will be displayed.

2.	 Press the ▶ button twice to select [SETUP] and press the ▼ button or the ENTER button to select [GEN-
ERAL].

3.	 Press the ▶ button to select [INSTALLATION].

4.	 Press the ▼ button three times to select [SECURITY] and press the ENTER button.

	 The OFF/ON menu will be displayed.

5. 	Press the ▼ button to select [ON] and press the ENTER button.

	 The [SECURITY KEYWORD] screen will be displayed.

6.	 Type in a combination of the four ▲▼◀▶ buttons and press the ENTER button.

NOTE: A keyword must be 4 to 10 digits in length.

	 The [CONFIRM KEYWORD] screen will be displayed.
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7.	 Type in the same combination of ▲▼◀▶ buttons and press the ENTER button.

	 The confirmation screen will be displayed.

8.	 Select [YES] and press the ENTER button.

	 The SECURITY function has been enabled.

To turn on the projector when [SECURITY] is enabled:

1.	 Press the POWER button.

	 The projector will be turned on and display a message to the effect that the projector is locked.

2.	 Press the MENU button.

3.	 Type in the correct keyword and press the ENTER button. The projector will display an image.

NOTE: The security disable mode is maintained until the main power is turned off or unplugging the power cord.
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To disable the SECURITY function:

1.	 Press the MENU button.

	 The menu will be displayed.

2. 	Select [SETUP] → [INSTALLATION] → [SECURITY] and press the ENTER button.

	 The OFF/ON menu will be displayed.

3.	 Select [OFF] and press the ENTER button.

	 The SECURITY KEYWORD screen will be displayed.

4.	 Type in your keyword and press the ENTER button.

	 When the correct keyword is entered, the SECURITY function will be disabled.

NOTE: If you forget your keyword, contact your dealer. Your dealer will provide you with your keyword in exchange for your request 
code. Your request code is displayed in the Keyword Confirmation screen. In this example [NB52-YGK8-2VD6-K585-JNE6-EYA8] 
is a request code.
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❼ Connecting Your Microphone
 
Connecting a commercially available dynamic microphone or condenser mic to the MIC input jack allows you to output 
your mic sound from the built-in speaker.

Sound input from all input terminals including APPS and USB-B will be heard from the speaker with your microphone 
voice. 
Select the microphone type (dynamic microphone or condenser microphone) from the menu [SETUP] → [INSTAL-
LATION] → [MIC SELECT].
Microphone sensitivity can be adjusted. From the menu, select [SETUP] → [INSTALLATION] → [MIC GAIN]. (→ page 64)

NOTE:
•	 Depending on input condition of HDMI1/MHL or HDMI2 signal, these is a case sound may not output.
•	 Do not connect an audio signal to the MIC input jack. Doing so may cause excessively loud sound, resulting in a damage to the 

speaker.

Dynamic microphone or condenser microphone
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❽ Operating Your Computer’s Mouse Functions from the 
Projector’s Remote Control via the USB Cable (Remote Mouse 
Function)
The built-in remote mouse function enables you to operate your computer’s mouse functions from the supplied remote 
control when the projector is connected to a computer via the USB cable supplied with the projector (compatible with 
USB 2.0 specifications).
Press the USB-B button on the remote control, or select [USB-B] for the source on the On-screen menu.
•	 Using the USB cable to connect the projector and the computer will also start USB Display function.

•	 When you connect your computer and the projector by a USB cable for the first time, your computer will read in 
the software. It will take few minutes for starting up the USB display.

USB cable (supplied)

NOTE:
•	 A USB cable must support the USB 2.0 Specifications.
•	 The mouse function can be used with the following operating systems:
	 Windows 8, Windows 7, or Windows Vista
•	 Wait at least 5 seconds after disconnecting the USB cable before reconnecting it and vice versa. The computer may not identify 

the USB cable if it is repeatedly connected and disconnected in rapid intervals.
•	 Connect the projector to the computer with a USB cable after starting the computer. Failure to do so may fail to start the computer.

Operating your computer’s mouse from the remote control
You can operate your computer’s mouse from the remote control.

PAGE ▽/△ Button	���������������������������scrolls the viewing area of the window or to move to the previous or next slide in PowerPoint 
on your computer.

▲▼◀▶ Buttons	������������������������������moves the mouse cursor on your computer.
MOUSE L-CLICK/ENTER Button	������works as the mouse left button.
MOUSE R-CLICK Button	������������������works as the mouse right button.

NOTE:
•	 When you operate the computer using the ▲▼◀ or ▶ button with the menu displayed, both the menu and the mouse pointer 

will be affected. Close the menu and perform the mouse operation.

TIP: You can change the Pointer speed on the Mouse Properties dialog box on the Windows. For more information, see the user 
documentation or online help supplied with your computer.
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❾ Projecting Your Computer’s Screen Image from the 
Projector via the USB Cable (USB Display)
Using the USB cable supplied with the projector (compatible with USB 2.0 specifications) to connect the computer with 
the projector allows you to send your computer screen image to the projector for displaying. Power On/Off and source 
selection of the projector can be done from your computer without connecting a computer cable (VGA).

NOTE:
•	 USB Display uses functions of Image Express Utility Lite contained on NEC Projector CD-ROM (→ page 93).
	 Starting USB Display, however, will not install Image Express Utility Lite on your computer. This is because USB Display executes 

the projector’s program only. 
•	 USB Display will not work in [NORMAL] of [STANDBY MODE]. (→ page 67)

1.	 Start the computer.

2.	 Turn on the projector and change the input source to [USB-B].

3.	 Use the USB cable to connect the computer with the projector.

USB cable (supplied)

→ To wall outlet
Power cord (supplied)

	 The message “The projector is in standby mode. Connect it?” will be displayed on the computer screen.

•	 The control window of Image Express Utility Lite will be displayed on the top of the screen.

NOTE: Depending on the computer setting, the “AutoPlay” window may be displayed when the 
computer detects the connection to the projector. If this happens, click the “Start USB Display” 
window.
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4.	 Operate the control window.

(1) (2) (3) (4) (5)(6)

(1)  (Source)	��� Selects an input source of the projector. 
(2)  (Picture)	��� Turns on or off AV-MUTE (Picture mute), FREEZE (Freeze a picture), display, and GCT (geometric correction 

tool). Refer to page 98 about GCT.
(3)  (Sound)	���� Turns on or off AV-MUTE (Sound mute), play the sound and control the volume.
(4)  (Others)	���� Uses for “Update”, “HTTP Server”*, “Settings” and “Information”.

*	 The HTTP Server cannot be selected when a USB cable is connected.
(5)  (Project)	��� Enables to change screen size for presentation, menu indication (hide/indicate), interruption prohibition/

accept interruption and finishing the USB Display.
It also enables to power off the projector at the same time with finishing the USB Display.

NOTE:
•	 When the USB cable is connected, you can not select to change below:

-	 Screen size for presentation
-	 menu indication (hide/indicate)
-	 Interruption prohibition/accept interruption

(6)  (Help)	����������� Displays the help of Image Express Utility Lite.
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❿ Using the stylus pen (Calibration)
Either when using the stylus pen for the first time or changing the installation place of the projector, make sure to 
perform calibration for letting the projector to recognize the stylus pen position properly.
There are three options for the pen set up.

AUTO CALIBRATION Adjust the stylus pen position automatically. Select this for easy adjustment.

MANUAL CALIBRATION Adjust the stylus pen position manually. Select this for precise position adjustment 
as for permanent projector installation.

REMOTE PEN Operation by a computer mouse can be performed by the stylus pen touch.
For utilizing the remote pen, connect the USB-B port on the projector and the USB-A 
port on the computer by the supplied USB cable.
NOTE:
•	 Before starting to use the remote pen, install the latest IWB Setup Software for the white 

board kit onto the computer and perform calibration. The latest IWB Setup Software for 
the white board kit is available to download from our web site:

	 http://www.nec-display.com/dl/en/pj_soft/lineup.html

After performing calibration of the stylus pen, you can use the stylus pen on the WHITEBOARD, etc. in the APPS MENU.

TIP:
•	 On the [PEN SETTINGS], you can also perform the adjustment of the separately sold Touch Module also. About the information 

for adjustment, refer the manual uploaded on our web site.

Automatic Calibration
1.	 Press APPS button on the remote.

	 The APPS MENU is displayed on.

2.	 Select [TOOL] → [PEN SETTINGS]

	 The [PEN SETTINGS] screen is displayed on.

3.	 Set the focus on the [AUTO CALIBRATION] and then press ENTER button.

	 Start calibration.

	 Position adjustment will be completed within 5 to 8 seconds and the message of the calibration completion will be 
displayed on.

Manual Calibration
1.	 Set the focus on the [MANUAL CALIBRATION] in the [PEN SETTINGS] and press ENTER.

	 The projection screen will switch to the manual calibration screen and a red dot will be indicated at the left top of 
the screen.

2.	 Touch the center of dot by the stylus pen.

•	 After touching the red dot, it moves to 25 positions in order.

3.	 Touch all 25 positions.

	 Complete the position adjustment and the message of calibration completion will be displayed on.

NOTE:
•	 You may not able to perform manual calibration by the affection of the light from outside.

http://www.nec-display.com/dl/en/pj_soft/lineup.html
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Remote Pen
1.	 Same as the “❽ Operating Your Computer’s Mouse Functions from the Projector’s Remote Control via the 

USB Cable (Remote Mouse Function)”, connect the projector and the computer by the supplied USB cable.

	 (→ page 39)

2.	 Set the focus on the [REMOTE PEN] in the [PEN SETTINGS] and press ENTER.

	 The checked mark is added.

3.	 Press the USB-B button on the remote.

•	 Or select [USB-B] as the [SOURCE] on the onscreen menu.

	 The computer screen will be displayed on.

4.	 Start the latest IWB Setup Software for the white board kit onto the computer and perform calibration.

	 The stylus pen becomes available for operations as a computer mouse.

NOTE:
•	 While the remote pen is available, the operations by a computer mouse can be performed by the stylus pen but the operations 

on the projector [APPS MENU] and the [WHITEBOARD] cannot be performed by the stylus pen.
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❶ Using the Menus

NOTE: The on-screen menu may not be displayed correctly while interlaced motion video image is projected.

1.	 Press the MENU button on the remote control or the projector cabinet to display the menu.

NOTE: The commands such as ENTER, EXIT, ▲▼, ◀▶ in the bottom show available buttons for your operation.

2.	 Press the ◀▶ buttons on the remote control or the projector cabinet to display the submenu.

3.	 Press the ENTER button on the remote control or the projector cabinet to highlight the top item or the first 
tab.

4.	 Use the ▲▼ buttons on the remote control or the projector cabinet to select the item you want to adjust or 
set.

	 You can use the ◀▶ buttons on the remote control or the projector cabinet to select the tab you want.

5.	 Press the ENTER button on the remote control or the projector cabinet to display the submenu window.

6.	 Adjust the level or turn the selected item on or off by using the ▲▼◀▶ buttons on the remote control or 
the projector cabinet.

Changes are stored until adjusted again.

7.	 Repeat steps 2 -6 to adjust an additional item, or press the EXIT button on the remote control or the projec-
tor cabinet to quit the menu display.

NOTE: When a menu or message is displayed, several lines of information may be lost, depending on the signal or settings.

8. 	Press the MENU button to close the menu.

	 To return to the previous menu, press the EXIT button.
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Menu Elements

Slide bar

Solid triangle

Tab

Radio button

High Altitude symbol

ECO mode symbol

Wireless symbol

Menu windows or dialog boxes typically have the following elements:
Highlight	����������������������������� Indicates the selected menu or item. 
Solid triangle	���������������������� Indicates further choices are available. A highlighted triangle indicates the item is active. 
Tab	�������������������������������������� Indicates a group of features in a dialog box. Selecting on any tab brings its page to the front.
Radio button	�����������������������Use this round button to select an option in a dialog box.
Source	�������������������������������� Indicates the currently selected source.
Off Timer remaining time	���� Indicates the remaining countdown time when the [OFF TIMER] is preset.
Slide bar	����������������������������� Indicates settings or the direction of adjustment.
ECO mode symbol	�������������� Indicates ECO MODE is set.
Key Lock symbol	���������������� Indicates the [CONTROL PANEL LOCK] is enabled.
Thermometer symbol	��������� Indicates the [ECO MODE] is forcibly set to [NORMAL] mode because the internal temperature is 

too high.
High Altitude symbol	���������� Indicates the [FAN MODE] is set to [HIGH ALTITUDE] mode.
Wireless symbol	����������������� Indicate the wireless LAN connection is enabled.
Menu mode	������������������������ Indicate the [ADVANCED] menu or [BASIC] menu.

Source

Available buttons

Thermometer symbol Key Lock symbol

Off Timer remaining time

Menu mode

Highlight
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❷ List of Menu Items
Some menu items are not available depending on the input source. The below listed menu items are on the advanced 
menu. The mark (B) is added to the items on the basic menu.
Refer to 88 pages about the APPS MENU.
Menu Item Default Options
SOURCE COMPUTER (B) *

HDMI1/MHL (B) *
HDMI2 (B) *
VIDEO (B) *
USB-B (B) *
APPS (B) *

ADJUST PICTURE PRESET * 1–7
DETAIL SETTINGS GENERAL

REFERENCE * HIGH-BRIGHT, PRESENTATION, VIDEO, MOVIE, GRAPHIC, sRGB, 
DICOM SIM.

GAMMA 
CORRECTION*1

DYNAMIC, NATURAL, BLACK DETAIL

SCREEN SIZE*2 * LARGE, MEDIUM, SMALL
COLOR TEMPERATURE * 5000, 6500, 7800, 8500, 9300, 10500
DYNAMIC CONTRAST * OFF, ON
IMAGE MODE * STILL, MOVIE
COLOR ENHANCEMENT * OFF, LOW, MIDDLE, HIGH

WHITE BALANCE
CONTRAST R 0
CONTRAST G 0
CONTRAST B 0
BRIGHTNESS R 0
BRIGHTNESS G 0
BRIGHTNESS B 0

CONTRAST (B) 63
BRIGHTNESS (B) 63
SHARPNESS (B) 7
COLOR (B) 31
HUE (B) 31
RESET (B)

IMAGE OPTIONS CLOCK *
PHASE *
HORIZONTAL *
VERTICAL *
OVERSCAN * AUTO, 0[%], 5[%], 10[%]
ASPECT RATIO * AUTO, 4:3, 16:9, 15:9, 16:10, LETTERBOX, NATIVE

AUDIO VOLUME (B)
SETUP GENERAL DIGITAL ZOOM (B) 100 70 to 100

KEYSTONE (B) KEYSTONE HORIZONTAL 0
KEYSTONE VERTICAL 0
CORNERSTONE 0
PINCUSHION 0 TOP, BOTTOM, LEFT, RIGHT, REFERENCE POSITION
RESET

WALL COLOR (B) OFF OFF, WHITEBOARD, BLACKBOARD, BLACKBOARD (GRAY), LIGHT 
YELLOW, LIGHT GREEN, LIGHT BLUE, SKY BLUE, LIGHT ROSE, PINK

ECO MODE (B) AUTO ECO OFF, AUTO ECO, NORMAL, ECO
CLOSED CAPTION OFF OFF, CAPTION1, CAPTION2, CAPTION3, CAPTION4, TEXT1, TEXT2, 

TEXT3, TEXT4
OFF TIMER (B) OFF OFF, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00, 16:00
TOOLS (B)
LANGUAGE (B) ENGLISH ENGLISH, DEUTSCH, FRANÇAIS, ITALIANO, ESPAÑOL, SVENSKA, 日

本語
DANSK, PORTUGUÊS, EŠTINA, MAGYAR, POLSKI, NEDERLANDS, 
SUOMI
NORSK, TÜRKÇE, РУССКИЙ, , Ελληνικά, 中文, 한국어, 
TIẾNG ViỆT
ROMÂNĂ, HRVATSKI, БЪЛГАРСКИ, INDONESIA, हिन्दी, 
ไทย, , 繁體中文

*	 The asterisk (*) indicates that the default setting varies depending on the signal.
*1	 The [GAMMA CORRECTION] item is available when an item other than [DICOM SIM.] is selected for [REFERENCE].
*2	 The [SCREEN SIZE] item is available when [DICOM SIM.] is selected for [REFERENCE].
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Menu Item Default Options
SETUP MENU COLOR SELECT COLOR COLOR, MONOCHROME

SOURCE DISPLAY ON OFF, ON
ID DISPLAY ON OFF, ON
ECO MESSAGE OFF OFF, ON
DISPLAY TIME AUTO 45 SEC MANUAL, AUTO 5 SEC, AUTO 15 SEC, AUTO 45 SEC
BACKGROUND BLUE BLUE, BLACK, LOGO
FILTER MESSAGE 5000(H) OFF, 100[H], 500[H], 1000[H], 2000[H], 5000[H]

INSTALLATION ORIENTATION DESKTOP 
FRONT

AUTO, DESKTOP FRONT, CEILING REAR, DESKTOP REAR, CEILING 
FRONT

CONTROL PANEL LOCK OFF OFF, ON
SECURITY OFF OFF, ON
COMMUNICATION SPEED 38400bps 4800bps, 9600bps, 19200bps, 38400bps
CONTROL ID CONTROL ID NUMBER 1 1–254

CONTROL ID OFF OFF, ON
TEST PATTERN
MIC SELECT DYNAMIC DYNAMIC, CONDENSOR
MIC GAIN
NETWORK SETTINGS

OPTIONS(1) AUTO ADJUST NORMAL OFF, NORMAL, FINE
SEAMLESS SWITCHING OFF, ON
FAN MODE AUTO AUTO, HIGH, HIGH ALTITUDE
SIGNAL SELECT COMPUTER RGB/

COMPONENT
RGB/COMPONENT, RGB, COMPONENT

VIDEO AUTO AUTO, NTSC3.58, NTSC4.43, PAL, PAL-M, PAL-N, PAL60, SECAM
WXGA MODE ON OFF, ON
DEINTERLACE ON OFF, ON
HDMI 
SETTINGS

HDMI1/
MHL

VIDEO LEVEL AUTO AUTO, NORMAL, ENHANCED

HDMI2 VIDEO LEVEL AUTO AUTO, NORMAL, ENHANCED
AUDIO 
SELECT

HDMI1/MHL HDMI1/MHL HDMI1/MHL, COMPUTER
HDMI2 HDMI2 HDMI2, COMPUTER
USB-B USB-B USB-B, COMPUTER

BEEP ON OFF, ON
OPTIONS(2) STANDBY MODE NORMAL NORMAL, NETWORK STANDBY

DIRECT POWER ON OFF OFF, ON
AUTO POWER ON OFF OFF, ON
AUTO POWER OFF 1:00 OFF, 0:05, 0:10, 0:20, 0:30, 1:00
DEFAULT SOURCE SELECT LAST LAST, AUTO, COMPUTER, HDMI1/MHL, HDMI2, VIDEO, USB-B, APPS
CARBON CONVERT
CURRENCY $, €, JP¥, RMB¥
CURRENCY CONVERT

*	 The asterisk (*) indicates that the default setting varies depending on the signal.
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Menu Item Default Options
INFO. USAGE TIME (B) LAMP LIFE REMAINING

LAMP HOURS USED
FILTER HOURS USED
TOTAL CARBON SAVINGS
TOTAL COST SAVINGS

SOURCE(1) (B) SOURCE NAME
SOURCE INDEX
HORIZONTAL FREQUENCY
VERTICAL FREQUENCY
SYNC TYPE SEPARATE SYNC, COMPOSITE SYNC, SYNC ON GREEN, SYNC ON 

VIDEO
SYNC POLARITY
SCAN TYPE INTERLACE, NON-INTERLACE

SOURCE(2) (B) SIGNAL TYPE RGB, COMPONENT, VIDEO, HDTV
VIDEO TYPE NTSC, NTSC3.58, NTSC4.43, PAL, PAL-M, PAL-N, PAL60, SECAM
BIT DEPTH 8[bits], 10[bits], 12[bits]
VIDEO LEVEL ENHANCED, FULL
MHL SIGNAL SUPPORTED, NOT SUPPORTED

WIRED LAN IP ADDRESS
SUBNET MASK
GATEWAY
MAC ADDRESS

WIRELESS LAN IP ADDRESS
SUBNET MASK
GATEWAY
MAC ADDRESS
SSID
NETWORK TYPE
SECURITY
CHANNEL
SIGNAL LEVEL

VERSION(1) (B) FIRMWARE
DATA

VERSION(2) (B) FIRMWARE2
OTHERS (B) PROJECTOR NAME (B)

HOST NAME (B)
MODEL NO. (B)
SERIAL NUMBER (B)
LAN UNIT TYPE
CONTROL ID (when [CONTROL ID] is set) (B)

RESET CURRENT SIGNAL
ALL DATA
CLEAR LAMP HOURS
CLEAR FILTER HOURS

*	 The asterisk (*) indicates that the default setting varies depending on the signal.
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❸ Menu Descriptions & Functions [SOURCE]

COMPUTER
Selects the computer connected to your COMPUTER input terminal signal.
NOTE: When the component input signal is connected to the COMPUTER IN terminal, select [COMPUTER].
 

HDMI1/MHL and HDMI2
Selects the HDMI compatible equipment connected to your HDMI1/MHL or 2 IN terminal.

VIDEO
Selects what is connected to your VIDEO input-VCR, DVD player or document camera.

USB-B
Selects the computer connected to the USB(PC) port (type B) by using the USB cable supplied with the projector. 
(→ page 39)

APPS
Display the APPS MENU or the function in the APPS MENU that was used last time.
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❹ Menu Descriptions & Functions [ADJUST]
[PICTURE]

[PRESET]
This function allows you to select optimized settings for your projected image.
You can adjust neutral tint for yellow, cyan or magenta. 
There are seven factory presets optimized for various types of images. You can also use [DETAIL SETTINGS] to set 
user adjustable settings to customize each gamma or color.
Your settings can be stored in [PRESET 1] to [PRESET 7].

HIGH-BRIGHT	�������� Recommended for use in a brightly lit room.
PRESENTATION	����� Recommended for making a presentation using a PowerPoint file.
VIDEO	�������������������� Recommended for typical TV program viewing.
MOVIE	������������������� Recommended for movies.
GRAPHIC	��������������� Recommended for graphics.
sRGB	��������������������� Standard color values
DICOM SIM.	���������� Recommended for DICOM simulation format.

NOTE: 
•	 The [DICOM SIM.] option is for training/reference only and should not be used for actual diagnosis.
•	 DICOM stands for Digital Imaging and Communications in Medicine. It is a standard developed by the American College of Radiol-

ogy (ACR) and the National Electrical Manufacturers Association (NEMA). 
	 The standard specifies how digital image data can be moved from system to system. 

[DETAIL SETTINGS]
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[GENERAL]

Storing Your Customized Settings [REFERENCE]
This function allows you to store your customized settings in [PRESET 1] to [PRESET 7].
First, select a base preset mode from [REFERENCE], then set [GAMMA CORRECTION] and [COLOR TEMPERATURE]. 

HIGH-BRIGHT	�������� Recommended for use in a brightly lit room.
PRESENTATION	����� Recommended for making a presentation using a PowerPoint file.
VIDEO	�������������������� Recommended for typical TV program viewing.
MOVIE	������������������� Recommended for movies.
GRAPHIC	��������������� Recommended for graphics.
sRGB	��������������������� Standard color values.
DICOM SIM.	���������� Recommended for DICOM simulation format.

Selecting Gamma Correction Mode [GAMMA CORRECTION]
Each mode is recommended for:

DYNAMIC	�������������� Creates a high-contrast picture.
NATURAL	��������������� Natural reproduction of the picture.
BLACK DETAIL	������� Emphasizes detail in dark areas of the picture.

NOTE: This function is not available when [DICOM SIM.] is selected for [DETAIL SETTINGS].

Selecting Screen Size for DICOM SIM [SCREEN SIZE]
This function will perform gamma correction appropriate for the screen size.

LARGE	������������������� For screen size of 110"
MEDIUM	���������������� For screen size of 90"
SMALL	������������������� For screen size of 70"

NOTE: This function is available only when [DICOM SIM.] is selected for [DETAIL SETTINGS].

Adjusting Color Temperature [COLOR TEMPERATURE]
This option allows you to select the color temperature of your choice.

NOTE: When [PRESENTATION] or [HIGH-BRIGHT] is selected in [REFERENCE], this function is not available.

Adjusting Brightness and Contrast [DYNAMIC CONTRAST]
This function allows you to adjust the contrast ratio optically using the built-in iris.
To increase the contrast ratio, select [ON].

Selecting Still Image Mode or Movie Mode [IMAGE MODE]
This function allows you to select the still image mode or the movie mode.

STILL	��������������������� This mode is for a still image.
MOVIE	������������������� This mode is for a movie.

NOTE: This function is available only when [HIGH-BRIGHT] is selected for [REFERENCE].
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Enhancing the Color [COLOR ENHANCEMENT]
This allows you to adjust the color density of the image.
The color of the image will become deeper in the order of "LOW", "MEDIUM", AND "HIGH" as the displayed image 
will become darker.
With "OFF" selected, the COLOR ENHANCEMENT function will not work.

NOTE: This function is available only when [PRESENTATION] is selected [REFERENCE].

Adjusting White Balance [WHITE BALANCE]
This allows you to adjust the white balance. Contrast for each color (RGB) to adjust the white level of the screen; 
Brightness for each color (RGB) is used to adjust the black level of the screen.

[CONTRAST]
Adjusts the intensity of the image according to the incoming signal.

[BRIGHTNESS]
Adjusts the brightness level or the back raster intensity.

[SHARPNESS]
Controls the detail of the image.

[COLOR]
Increases or decreases the color saturation level.

[HUE]
Varies the color level from +/− green to +/− blue. The red level is used as reference.

Input signal CONTRAST BRIGHTNESS SHARPNESS COLOR HUE

COMPUTER/HDMI (RGB) Yes Yes Yes No No

COMPUTER/HDMI (COMPONENT) Yes Yes Yes Yes Yes

USB-B Yes Yes Yes No No

VIDEO Yes Yes Yes Yes Yes

APPS Yes Yes Yes No No

Yes = Adjustable, No = Not adjustable

[RESET]
The settings and adjustments for [PICTURE] will be returned to the factory settings with the exception of the following; 
Preset numbers and [REFERENCE] within the [PRESET] screen.
The settings and adjustments under [DETAIL SETTINGS] within the [PRESET] screen that are not currently selected 
will not be reset.
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[IMAGE OPTIONS]

Adjusting Clock and Phase [CLOCK/PHASE]
This allows you to manually adjust CLOCK and PHASE.

CLOCK	������������������� Use this item to fine tune the computer image or to remove any vertical banding that might appear. This 
function adjusts the clock frequencies that eliminate the horizontal banding in the image.
This adjustment may be necessary when you connect your computer for the first time.

PHASE	������������������� Use this item to adjust the clock phase or to reduce video noise, dot interference or cross talk. (This is 
evident when part of your image appears to be shimmering.)
Use [PHASE] only after the [CLOCK] is complete.
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Adjusting Horizontal/Vertical Position [HORIZONTAL/VERTICAL]
Adjusts the image location horizontally and vertically.

-	 An image can be distorted during the adjustment of [CLOCK] and [PHASE]. This is not malfunction.

-	 The adjustments for [CLOCK], [PHASE], [HORIZONTAL], and [VERTICAL] will be stored in memory for the 
current signal. The next time you project the signal with the same resolution, horizontal and vertical frequency, 
its adjustments will be called up and applied.

	 To delete adjustments stored in memory, from the menu, you select [RESET] → [CURRENT SIGNAL] or [ALL 
DATA] and reset the adjustments.

Selecting Overscan Percentage [OVERSCAN]
Select overscan percentage (AUTO, 0%, 5% and 10%) for signal.

Projected image

Overscaned by 10%

NOTE: 
•	 The [0[%]] cannot be selected when VIDEO signal is used.
•	 The [OVERSCAN] item is not available:

-	 when [NATIVE] is selected for [ASPECT RATIO].
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Selecting Aspect Ratio [ASPECT RATIO]
The term “aspect ratio” refers to the ratio of width to height of a projected image.
The projector automatically determines the incoming signal and displays it in its appropriate aspect ratio.
•	 This table shows typical resolutions and aspect ratios that most computers support.

Resolution Aspect Ratio
VGA 640 × 480 4:3
SVGA 800 × 600 4:3
XGA 1024 × 768 4:3
WXGA 1280 × 768 15:9
WXGA 1280 × 800 16:10
WXGA+ 1440 × 900 16:10
SXGA 1280 × 1024 5:4
SXGA+ 1400 × 1050 4:3
UXGA 1600 × 1200 4:3
WUXGA 1920 × 1200 16:10

Options Function

AUTO The projector will automatically determine the incoming signal and display it in its aspect 
ratio. (→ next page)
The projector may erroneously determine the aspect ratio depending on its signal. If this 
occurs, select the appropriate aspect ratio from the following.

4:3 The image is displayed in 4:3 aspect ratio.

16:9 The image is displayed in 16:9 aspect ratio.

15:9 The image is displayed in 15:9 aspect ratio.

16:10 The image is displayed in 16:10 aspect ratio.

LETTERBOX The image of a letterbox signal is stretched equally in the horizontal and vertical direc-
tions to fit the screen. Parts of the displayed image are cropped at the top and bottom 
edges and therefore not visible.

NATIVE The projector displays the current image in its true resolution when the incoming computer 
signal has a lower resolution than the projector’s native resolution.

[Example] When the incoming signal with the resolution of 
800 × 600 is displayed:

NOTE:
•	 When a non-computer signal is displayed, the [NATIVE] is not available.
•	 When a signal with a higher resolution than the projector’s native resolution is displayed, [NA-

TIVE] is not available.
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Sample image when the appropriate aspect ratio is automatically determined
[Computer signal]
Aspect ratio of incoming signal 4:3 5:4 16:9 15:9 16:10

Sample image when the appro-
priate aspect ratio is automati-
cally determined

[Video signal]
Aspect ratio of incoming signal 4:3 Letterbox Squeeze

Sample image when the aspect 
ratio is automatically determined

NOTE: To display a letterbox signal prop-
erly, select [LETTERBOX].

NOTE: To display a squeezed signal prop-
erly, select [16:9].

TIP:
•	 The term “letterbox” refers to a more landscape-oriented image when compared to a 4:3 image, which is the standard aspect 

ratio for a video source.
	 The letterbox signal has aspect ratios with the vista size “1.85:1” or cinema scope size “2.35:1” for movie film.
•	 The term “squeeze” refers to the compressed image of which aspect ratio is converted from 16:9 to 4:3.
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[AUDIO]

Turning Up or Down Sound
Adjusts the volume of the projector speaker and AUDIO OUT (Stereo Mini Jack).

TIP:
•	 When no menus appear, the ◀ and ▶ buttons on the projector cabinet and the VOL. +/− buttons on the remote control work as 

a volume control. (→ page 23)
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❺ Menu Descriptions & Functions [SETUP]

[GENERAL]

Using Digital Zoom [DIGITAL ZOOM]
This feature allows you to electronically fine adjust the image size on the screen.

NOTE:
•	 This feature can not be used when [USB-B] is selected as a input terminal.

TIP: To adjust the projected image size roughly, move the projector away or closer to the screen. To fine adjust the zoom, use the 
[DIGITAL ZOOM] function. (→ page 20)

Correcting Keystone Distortion Manually [KEYSTONE]
You can correct horizontal or vertical keystone, pincushion, or cornerstone distortion manually.

NOTE:
•	 Some items are not available when one item is activated. Unavailable items are shown in grey.
•	 To change from one item to another item, reset the first item.
•	 Adjustment values will be overwritten. They will not be deleted even when the projector is turned off.
•	 Using [KEYSTONE], [PINCUSHION] and [CORNERSTONE] correction can cause the image to be slightly blurred because the 

correction is made electronically.

KEYSTONE HORIZONTAL	���Corrects horizontal keystone distortion. (→ page 21)
KEYSTONE VERTICAL	��������Corrects vertical keystone distortion. (→ page 21)
CORNERSTONE	������������������Fits a projected image within the border of the screen easily by align the four corner of an image to 

the ones of the screen. (→ page 31)
PINCUSHION	����������������������Corrects pincushion distortion at the top, bottom, left, or right side. By moving the reference point, 

enable to move the top position of the correction curve.
RESET	���������������������������������Returns all the above items to the factory preset values.

TIP:
•	 Adjustable angle range in horizontal and vertical direction in the cornerstone and the keystone corrections: Approx. 10 degrees 

(Max)
-	 Depending on input signal, the adjustable range may be narrower.
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Using the Wall Color Correction [WALL COLOR]

This function allows for quick adaptive color correction in applications where the screen material is not white.

NOTE: Selecting [WHITEBOARD] reduces lamp brightness.

Setting Eco Mode [ECO MODE]
The ECO MODE increases lamp life, while lowering power consumption and cutting down on CO2 emissions. 
Four brightness modes of the lamp can be selected: [OFF], [AUTO ECO], [NORMAL] and [ECO] modes. 
(→ page 29)

Setting Closed Caption [CLOSED CAPTION]
This option sets several closed caption modes that allow text to be superimposed on the projected image of Video 
or S-Video.

OFF	������������������������ This exits the closed caption mode.
CAPTION 1-4	��������� Text is superimposed.
TEXT 1-4	���������������� Text is displayed.

NOTE:
•	 The closed caption is not available under the following conditions:

-	 when messages or menus are displayed.
-	 when an image is magnified, frozen, or muted.

•	 Portions of superimposed text or closed caption may be truncated. If that happens, try to place the superimposed text or closed 
caption within the screen.

Using Off Timer [OFF TIMER]
1.	 Select your desired time between 30 minutes and 16 hours: OFF, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00, 16:00.

2.	 Press the ENTER button on the remote control.

3.	 The remaining time starts counting down.

4.	 The projector will turn off after the countdown is complete.

NOTE:
•	 To cancel the preset time, set [OFF] for the preset time or turn off the power.
•	 When the remaining time reaches 3 minutes before the projector is turned off, the [THE PROJECTOR WILL TURN OFF WITHIN 3 

MINUTES] message will be displayed on the bottom of the screen.

Display the tools menu [TOOLS]
This function display the tools menu. (→ page 90)

Selecting Menu Language [LANGUAGE]
You can choose one of 30 languages for on-screen instructions.

NOTE: Your setting will not be affected even when [RESET] is done from the menu.
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[MENU]

Selecting Menu Color [COLOR SELECT]
You can choose between two options for menu color: COLOR and MONOCHROME.

Turning On / Off Source Display [SOURCE DISPLAY]
This option turns on or off input name display such as COMPUTER, HDMI1/MHL, HDMI2, VIDEO, USB-B, APPS, to 
be displayed on the top right of the screen.
When no input signal is present, the no-signal guidance prompting you to check for an available input will be displayed at 
the center of the screen. When the [APPS] item is selected for [SOURCE], the no-signal guidance will not be displayed.

Turning ON/OFF Control ID [ID DISPLAY]
ID DISPLAY	����������� This option turns on or off the ID number which is displayed when the ID SET button on the remote control 

is pressed.

Turning On / Off Eco Message [ECO MESSAGE]
This option turns on or off the following messages when the projector is turned on. 

The Eco Message prompts the user to save energy. When [OFF] is selected for [ECO MODE], you will get a message 
to prompt you to select [AUTO ECO], [NORMAL], or [ECO] for [ECO MODE].

When [AUTO ECO], [NORMAL], or [ECO] is selected for [ECO MODE]

To close the message, press any one of the buttons. The message will disappear if no button operation is done for 
30 seconds.

When [OFF] is selected for [ECO MODE]

Pressing the ENTER button will display the [ECO MODE] screen. (→ page 29)
To close the message, press the EXIT button.
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Selecting Menu Display Time [DISPLAY TIME]
This option allows you to select how long the projector waits after the last touch of a button to turn off the menu. The 
preset choices are [MANUAL], [AUTO 5 SEC], [AUTO 15 SEC], and [AUTO 45 SEC]. The [AUTO 45 SEC] is the fac-
tory preset.

Selecting a Color or Logo for Background [BACKGROUND]
Use this feature to display a blue/black screen or logo when no signal is available. The default background is [BLUE].
NOTE: 
•	 If the [LOGO] item is selected for [BACKGROUND] with the [USB-B] source selected, the [BLUE] item will be selected regardless 

of its selection.
•	 When [SOURCE DISPLAY] is turned on, the no-signal guidance prompting you to check for an available input will be displayed 

at the center of the screen regardless of its selection.
•	 Your setting will not be affected even when [RESET] is done from the menu.

Selecting Interval Time for Filter Message [FILTER MESSAGE]
This option allows you to select the time preference between displaying the message for cleaning the filters. Clean 
the filter when you get the message “PLEASE CLEAN THE FILTER.” (→ page 112)
Six options are available: 

OFF, 100[H], 500[H], 1000[H], 2000[H], 5000[H]

NOTE: Your setting will not be affected even when [RESET] is done from the menu.
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[INSTALLATION]

Selecting Projector Orientation [ORIENTATION]
This reorients your image for your type of projection. The options are: desktop front projection, ceiling rear projection, 
desktop rear projection, and ceiling front projection.

AUTO
When the lamp is turned ON, the inner sensor of the projector detects its installation state either DESK FRONT or 
CEILING FRONT and then switch its projection method

DESKTOP FRONT CEILING REAR

DESKTOP REAR CEILING FRONT

Disabling the Cabinet Buttons [CONTROL PANEL LOCK]
This option turns on or off the CONTROL PANEL LOCK function.

NOTE:
•	 This CONTROL PANEL LOCK does not affect the remote control functions.
•	 How to release the CONTROL PANEL LOCK

1.	When the projector is projecting image or in the sleep mode, press and hold the SOURCE button on the projector cabinet for 
about 10 seconds. The CONTROL PANEL LOCK will be released.

2.	When the projector is in the standby mode, press and hold the POWER button on the projector cabinet. It enables to power on 
the projector. After checking the projector is projecting image, perform the previous step 1. 

TIP: When the [CONTROL PANEL LOCK] is turned on, a key lock icon [  ] will be displayed at the bottom right of the menu.
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Enabling Security [SECURITY]
This feature turns on or off the SECURITY function.
Unless the correct keyword is entered, the projector cannot project an image. (→ page 35)

NOTE: Your setting will not be affected even when [RESET] is done from the menu.

Selecting Communication Speed [COMMUNICATION SPEED]
This feature sets the baud rate of the PC Control port (D-Sub 9P). It supports data rates from 4800 to 38400 bps. The 
default is 38400 bps. Select the appropriate baud rate for your equipment to be connected (depending on the equip-
ment, a lower baud rate may be recommended for long cable runs).

NOTE: Your selected communication speed will not be affected even when [RESET] is done from the menu.

Setting ID to the Projector [CONTROL ID]
You can operate multiple projectors separately and independently with the single remote control that has the CONTROL 
ID function. If you assign the same ID to all the projectors, you can conveniently operate all the projectors together 
using the single remote control. To do so, you have to assign an ID number to each projector.

CONTROL ID NUMBER	�������Select a number from 1 to 254 you wish to assign to your projector.
CONTROL ID	�����������������������Select [OFF] to turn off the CONTROL ID setting and select [ON] to turn on the CONTROL ID setting.

NOTE: 
•	 When [ON] is selected for [CONTROL ID], the projector cannot be operated by using the remote control that does not support 

the CONTROL ID function. (In this case the buttons on the projector cabinet can be used.)
•	 Your setting will not be affected even when [RESET] is done from the menu.
•	 Pressing and holding the ENTER button on the projector cabinet for 10 seconds will display the menu for canceling the Control 

ID.

Assigning or Changing the Control ID

1.	 Turn on the projector.

2.	 Press the ID SET button on the remote control.

	 The CONTROL ID screen will be displayed.

	 If the projector can be operated with the current remote control ID, the [ACTIVE] will 
be displayed. If the projector cannot be operated with the current remote control ID, 
the [INACTIVE] will be displayed. To operate the inactive projector, assign the control 
ID used for the projector by using the following procedure (Step 3).

＋
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3.	 Press one of numeric keypad buttons while pressing and holding the ID SET 
button on the remote control.

	 Example:

	 To assign “3”, press the “3” button on the remote control.

	 No ID means that all the projectors can be operated together with a single remote 
control. To set “No ID”, enter “000” or press the CLEAR button.

TIP: The range of IDs is from 1 to 254.

4.	 Release the ID SET button.

	 The updated CONTROL ID screen will be displayed.

NOTE: 
•	 The IDs can be cleared in a few days after the batteries are run down or removed.
•	 Accidentally pressing any one of the buttons of the remote control will clear currently specified 

ID with batteries removed.

Using Test Pattern [TEST PATTERN]
Displays the test pattern to check for image distortion at the time of the projector setup. Press the ENTER button to 
display the test pattern; press the EXIT button to close the test pattern and return to the menu. Menu operation and 
corrections for keystone, cornerstone and pincushion are not available when the test pattern is displayed.

Selecting Microphone Type [MIC SELECT]
This feature allows you to select dynamic or condenser type for your microphone.

Setting MIC Gain [MIC GAIN]
This feature allows you to adjust your microphone sensitivity when it is connected to the MIC input jack of the projec-
tor. Microphone volume can be adjusted with the VOL. (+) or (−) button on the remote control or the ◀ or ▶ on the 
projector cabinet.

Setting the network [NETWORK SETTINGS]
This function display the network settings menu. (→ page 90)
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[OPTIONS(1)]

Setting Auto Adjust [AUTO ADJUST]
This feature sets the Auto Adjust mode so that the computer signal can be automatically or manually adjusted for 
noise and stability. You can automatically make adjustment in two ways: [NORMAL] and [FINE].

OFF	������������������������ The computer signal will not be automatically adjusted. You can manually optimize the computer signal.
NORMAL	���������������� Default setting. The computer signal will be automatically adjusted. Normally select this option.
FINE	����������������������� Select this option if fine adjustment is needed. It takes more time to switch to the source than when [NOR-

MAL]is selected.

[SEAMLESS SWITCHING]
When the input terminal is switched, the image displayed before switching is held to switch to the new image without 
a break due to absence of a signal.

Selecting Fan Mode [FAN MODE]
This option allows you to select three modes for fan speed: Auto mode, High speed mode, and High Altitude mode.

AUTO	��������������������� The built-in fans automatically run at a variable speed according to the internal temperature.
HIGH	���������������������� The built-in fans run at high speed.
HIGH ALTITUDE	����� The built-in fans run at a high speed. Select this option when using the projector at altitudes approximately 

5500 feet/1700 meters or higher.

When you wish to cool down the temperature inside the projector quickly, select [HIGH].

NOTE: 
•	 It is recommended that you select High speed mode if you use the projector non-stop for consecutive days.
•	 Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 5500 feet/1700 meters or higher.
•	 Using the projector at altitudes approximately 5500 feet/1700 meters or higher without setting to [HIGH ALTITUDE] can cause 

the projector to overheat and the protector could shut down. If this happens, wait a couple minutes and turn on the projector.
•	 Using the projector at altitudes less than approximately 5500 feet/1700 meters and setting to [HIGH ALTITUDE] can cause the 

lamp to overcool, causing the image to flicker. Switch [FAN MODE] to [AUTO].
•	 Using the projector at altitudes approximately 5500 feet/1700 meters or higher can shorten the life of optical components such 

as the lamp.
•	 Your setting will not be affected even when [RESET] is done from the menu.

TIP: 
•	 When [HIGH ALTITUDE] is selected, an icon [   ] is displayed at the bottom of the on-screen menu.
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Selecting Signal Format [SIGNAL SELECT]
[COMPUTER]
Allows you to choose [COMPUTER] for an RGB source such as a computer, or [COMPONENT] for a component 
video source such as a DVD player. Normally select [RGB/COMPONENT] and the projector automatically detects a 
component signal. However there may be some component signals that the projector is unable to detect. If this is the 
case, select [COMPONENT].

[VIDEO & S-VIDEO System Select]
This feature enables you to select composite video standards automatically or manually.
Normally select [AUTO] and the projector will automatically detect the video standard.
In the case where the projector has difficulty detecting the video standard, select the appropriate video standard from 
the menu.
This must be done for VIDEO and S-VIDEO respectively.

Enabling or Disabling WXGA Mode [WXGA MODE]
Selecting [ON] will give priority to WXGA (1280 × 768)/WUXGA (1920 × 1200) signals in recognizing an input signal.
When [WXGA MODE] is set to [ON], XGA (1024 × 768)/UXGA (1600 × 1200) signals may not be recognized. In this 
case, select [OFF].

NOTE: 
•	 The [ON] is selected at the time of shipment.

Enabling the deinterlace [DEINTERLACE]
Turns on or off the deinterlace function for a telecine signal.

OFF	������������������������ Select this option if there is any jitter or artifacts in video.
ON	������������������������� Default standard setting.

NOTE: This feature is not available for HDTV (progressive) and computer signals.

Setting HDMI1/MHL & HDMI2 [HDMI SETTINGS]
Make the settings for each video level when connecting HDMI1/MHL equipment such as a DVD player. 

VIDEO LEVEL	��������� Select [AUTO] to automatically detect video level. If automatic detection may not work well, select [NOR-
MAL] to disable the [ENHANCED] feature of your HDMI equipment or select [ENHANCED] to improve image 
contrast and increase detail in the dark areas.

Setting Audio [AUDIO SELECT]
Make the settings for each audio level when connecting HDMI equipment and USB (PC) terminal. Select between 
each equipment and computer.

HDMI1/MHL, HDMI2	���� Select [HDMI1/MHL] or [HDMI2] to switch the HDMI1/MHL IN or HDMI 2 IN digital audio signal or select 
[COMPUTER] to switch the COMPUTER input audio signal.

USB-B	�������������������� Select [USB-B] or [COMPUTER] to switch the source connected over the USB cable (USB-B).

Enabling Key Sound and Error Sound [BEEP]
This feature turns on or off the button sound or alarm when an error occurs or the following operations are performed.

- Displaying the main menu 

- Switching sources

- Resetting data by using [RESET]

- Pressing POWER ON or STANDBY button
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[OPTIONS(2)]

Selecting Power-saving in [STANDBY MODE]
The projector has two standby modes: [NORMAL] and [NETWORK STANDBY].
The NORMAL mode is the mode that allows you to put the projector in the power-saving condition which consumes 
less power than the NETWORK STANDBY mode.

NORMAL	�����������������������������POWER indicator: Red light/STATUS indicator: Off
When [NORMAL] is selected, only the following buttons and feature will work:
POWER button on the projector cabinet and the remote control, powering on from PC Control 
command, and AUTO POWER ON.

NETWORK STANDBY	����������POWER indicator: Orange light/STATUS indicator: Off
When [NETWORK STANDBY] is selected, the projector can be turned on over a wired LAN connec-
tion and only the following buttons, port, and features will work:
POWER button on the projector cabinet and the remote control, powering on from PC Control 
command, AUTO POWER ON, Operation by User Supportware, Network service, Program Timer.

Important:
•	 In the below conditions, setting of the [STANDBY MODE] is disabled and the projector will go into the SLEEP mode*.

*	 Sleep mode refers the mode without functional restrictions by the [STANDBY MODE]. Power consumption in the SLEEP mode 
is relatively higher than the [NETWORK STANDBY] mode. The Status indicator turns on in Green.

	 When [STANDBY MODE] → [NETWORK STANDBY] is selected
-	 When [NETWORK SERVICE] → [AMX SETTINGS] → [ENABLE] is selected 
-	 When [NETWORK SERVICE] → [CRESTRON SETTINGS] → [CRESTRON CONTROL] → [ENABLE] is selected
-	 When [NETWORK SETTINGS] → [WIRELESS LAN] → Except for [DISABLE] and mounting the wireless LAN unit to the projector
-	 When the signal is input to the computer, HDMI1/MHL or HDMI2 terminals

	 Regardless of the [STANDBY MODE]
-	 When the USB cable is connected to the projector and the computer

NOTE: 
•	 Even when [NORMAL] is selected for [STANDBY MODE], power on or off can be done by using the PC CONTROL port.
•	 The power consumption in the standby mode will not be included in calculating CO2 emission reduction.
•	 Your setting will not be affected even when [RESET] is done from the menu.

Enabling Direct Power On [DIRECT POWER ON]
Turns the projector on automatically when the power cord is inserted into an active power outlet. This eliminates the 
need to always use the POWER button on the remote control or projector cabinet.
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Turning On the Projector By Applying Computer Signal [AUTO POWER ON]
When the projector is in Standby mode, applying a computer or HDMI signal from a computer connected to the 
COMPUTER IN input, HDMI1/MHL, or HDMI2 input will power on the projector and simultaneously project the image.
This functionality eliminates the need to always use the POWER button on the remote control or the projector cabinet 
to power on the projector.
To use this function, first connect a computer to the projector and the projector to an active AC input.

NOTE: 
•	 Disconnecting a computer signal from the computer will not power off the projector. We recommend using this function in com-

bination of the AUTO POWER OFF function.
•	 This function will not be available under the following conditions:

-	 when a component signal is applied to the COMPUTER IN terminal
-	 when a Sync on Green RGB signal or composite sync signal is applied
-	 when MHL signal is spplied to HDMI1/MHL IN terminal

•	 To enable the AUTO POWER ON after changing to the sleep mode turning off the projector, wait 5 seconds and input a computer 
or HDMI signal.

	 If a computer or HDMI signal is still present when the projector is turned off, the AUTO POWER ON will not work and the projector 
remains in standby mode.

Enabling Power Management [AUTO POWER OFF]
The projector has power management functions. To reduce power consumption, the power management functions (1 
and 2) are factory preset as shown below. To control the projector from an external device via a LAN or serial cable 
connection, use the on-screen menu to change the settings for 1 and 2.

1.	 STANDBY MODE (Factory preset: NORMAL)

	 To control the projector from an external device, select [NETWORK STANDBY] for [STANDBY MODE].

NOTE:
•	 When [NORMAL] is selected for [STANDBY MODE], the following terminals and functions will not work:
	 MONITOR OUT terminal, AUDIO OUT terminal, LAN functions, Mail Alert function, DDC/CI (Virtual Remote Tool)

2.	 AUTO POWER OFF (Factory preset: 1 hour)

	 To control the projector from an external device, select [OFF] for [AUTO POWER OFF].

NOTE:
•	 When [1:00] is selected for [AUTO POWER OFF], you can enable the projector to automatically turn off in 60 minutes if there is 

no signal received by any input or if no operation is performed.
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Selecting Default Source [DEFAULT SOURCE SELECT]
You can set the projector to default to any one of its inputs each time the projector is turned on.

LAST	���������������������� Sets the projector to default to the previous or last active input each time the projector is turned on.
AUTO	��������������������� Searches for an active source in order of COMPUTER → HDMI1/MHL → HDMI2 → VIDEO → COMPUTER 

and displays the first found source.
COMPUTER	����������� Displays the computer signal from the COMPUTER IN terminal every time the projector is turned on.
HDMI1/MHL	���������� Displays the digital source from the HDMI 1/MHL IN terminal every time the projector is turned on. 
HDMI2	������������������� Displays the digital source from the HDMI 2 IN terminal every time the projector is turned on. 
VIDEO	�������������������� Displays the Video source from the VIDEO IN terminal every time the projector is turned on.
USB-B	�������������������� Displays the computer signal from the USB (PC) terminal every time the projector is turned on.
APPS	��������������������� Display the APPS MENU.

NOTE:
•	 [USB-B] and [APPS] can not be detected when [AUTO] is selected. For projecting image from USB-B or APPS, select [USB-B], 

[APPS] or [LAST].

Setting carbon footprint factor [CARBON CONVERT]
Adjusts the carbon footprint factor in the carbon saving calculation. The initial setting is 0.505[kg-CO2/kWh] based on 
the CO2 Emissions from Fuel Combustion (2008 Edition) published by OECD.

Selecting your currency [CURRENCY]
Displays electricity pricing (available in 4 currency units).

$	���������������������������� US Dollar
€	��������������������������� EU Euro
JP¥	������������������������ Japanese Yen
RMB¥	�������������������� Chinese Yuan

Changing currency setting and currency convert setting [CURRENCY CONVERT]
Changes currency setting and currency convert setting for CARBON METER.
The initial setting are as follows:

US Dollar	��������������� 0.11 [$/kWh]
EU Euro	����������������� 0.19 [€/kWh]
Japanese Yen	��������� 20 [¥/kWh]
Chinese Yuan	��������� 0.48 [¥/kWh]

The initial settings for US dollar, EU Euro, and Japanese Yen are based on “Energy Prices and Taxes (second quarter 
2010” published by OECD.
The initial setting for Chinese Yuan is based on “Chinese Data File (2010)” published by JETRO.
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❻ Menu Descriptions & Functions [INFO.]
Displays the status of the current signal and lamp usage. This item has six pages. The information included is as follows:

TIP: Pressing the HELP button on the remote control will show the [INFO.] menu items.

[USAGE TIME]

[LAMP LIFE REMAINING] (%)*
[LAMP HOURS USED] (H)
[FILTER HOURS USED] (H)
[TOTAL CARBON SAVINGS] (kg-CO2)
[TOTAL COST SAVINGS]

*	 The progress indicator shows the percentage of remaining bulb life.

	 The value informs you of the amount of lamp usage. When the remaining lamp time reaches 0, the LAMP LIFE 
REMAINING bar indicator changes from 0% to 100 Hours and starts counting down.

	 If the remaining lamp time reaches 0 hours, the projector will not turn on.

•	 The message to the effect that the lamp or the filters should be replaced will be displayed for one minute when 
the projector is turned on and when the POWER button on the projector or the remote control is pressed.

	 To dismiss this message, press any button on the projector or the remote control.

Lamp life(H)
Replacement lampECO MODE

OFF/AUTO ECO NORMAL ECO
3800 5000 6000 NP33LP

•	 [TOTAL CARBON SAVINGS]

	 This displays the estimated carbon saving information in kg. The carbon footprint factor in the carbon saving cal-
culation is based on the OECD (2008 Edition). (→ page 30)
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[SOURCE(1)]

[SOURCE NAME]	 [SOURCE INDEX]
[HORIZONTAL FREQUENCY]	 [VERTICAL FREQUENCY]
[SYNC TYPE]	 [SYNC POLARITY]
[SCAN TYPE]

[SOURCE(2)]

[SIGNAL TYPE]	 [VIDEO TYPE]
[BIT DEPTH]	 [VIDEO LEVEL]
[MHL SIGNAL]

[WIRED LAN]

[IP ADDRESS]	 [SUBNET MASK]
[GATEWAY]	 [MAC ADDRESS]
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[WIRELESS LAN]

[IP ADDRESS]	 [SUBNET MASK]	
[GATEWAY]	 [MAC ADDRESS]	
[SSID]	 [NETWORK TYPE]	
[SECURITY]	 [CHANNEL]	
[SIGNAL LEVEL]

[VERSION(1)]

[FIRMWARE] Version
[DATA] Version

[VERSION(2)]

[FIRMWARE2] Version
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[OTHERS]

[PROJECTOR NAME]
[HOST NAME]
[MODEL NO.]
[SERIAL NUMBER]
[LAN UNIT TYPE]
[CONTROL ID] (when [CONTROL ID] is set)
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❼ Menu Descriptions & Functions [RESET]

Returning to Factory Default [RESET]
The RESET feature allows you to change adjustments and settings to the factory preset for a (all) source (s) except 
the following:

[CURRENT SIGNAL]
Resets the adjustments for the current signal to the factory preset levels. 
The items that can be reset are: [PRESET], [CONTRAST], [BRIGHTNESS], [COLOR], [HUE], [SHARPNESS], 
[ASPECT RATIO], [HORIZONTAL], [VERTICAL], [CLOCK], [PHASE], and [OVERSCAN].

[ALL DATA]
Reset all the adjustments and settings for all the signals to the factory preset.
All items can be reset EXCEPT [LANGUAGE], [BACKGROUND], [FILTER MESSAGE], [SECURITY], [COMMUNI-
CATION SPEED], [CONTROL ID], [STANDBY MODE], [FAN MODE], [LAMP LIFE REMAINING], [LAMP HOURS 
USED], [FILTER HOURS USED], [TOTAL CARBON SAVINGS], [PROJECTOR NAME], [WIRED LAN], [WIRELESS 
LAN], [IMAGE EXPRESS UTILITY LITE], [NETWORK SERVICE], [DATE & TIME], [ADMINISTRATOR MODE], 
and [REMOTE DESKTOP CONNECTION].
To reset the lamp usage time, see “Clearing Lamp Hour Meter [CLEAR LAMP HOURS]” below.

Clearing Lamp Hour Meter [CLEAR LAMP HOURS]
Resets the lamp clock back to zero. Selecting this option displays submenu for a confirmation. Select [YES] and press 
the ENTER button.

NOTE: Elapsed time of the lamp use will not be affected even when [RESET] is done from the menu.

NOTE: The projector will turn off and go into standby mode when you continue to use the projector for another 100 hours after the 
lamp has reached the end of its life. In this condition you cannot clear the lamp hour meter on the menu. If this happens, press 
the HELP button on the remote control for 10 seconds to reset the lamp clock back to zero. Do this only after replacing the lamp.

Clearing the Filter Usage Hours [CLEAR FILTER HOURS]
Resets the filter usage back to zero. Selecting this option displays submenu for a confirmation. Select [YES] and press 
the ENTER button.

NOTE: Elapsed time of the filter use will not be affected even when [RESET] is done from the menu.
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❶ Setting Up the Screen and the Projector
The further your projector is from the screen or wall, the larger the image. The minimum size the image can be is 58" 
(1473 mm) measured diagonally when the projector is 4 inches (105 mm) between the screen side of the projector 
and the wall or screen. The largest the image can be is 110" (2794 mm) when the projector is 20 inches (510 mm) 
between the screen side of the projector and the wall or screen. 

Screen Size
H1 H2

L1 L2
Diagonal Width Height wide

inch mm inch mm inch mm inch mm inch mm inch mm inch mm
58 1473 49 1249 31 781 9 239 40 1020 4 105 18 448
60 1524 51 1292 32 808 10 244 41 1051 5 120 18 464
70 1778 59 1508 37 942 11 267 48 1210 8 198 21 542
80 2032 68 1723 42 1077 11 291 54 1368 11 276 24 620
90 2286 76 1939 48 1212 12 315 60 1527 14 354 27 698
100 2540 85 2154 53 1346 13 339 66 1685 17 432 31 776
110 2794 93 2369 58 1481 14 363 73 1843 20 510 34 854 
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WARNING
*	 Installing your projector on the ceiling must be done by a qualified technician. Contact your NEC dealer for more 

information.
*	 Do not attempt to install the projector yourself.
•	 Only use your projector on a solid, level surface. If the projector falls to the ground, you can be injured and the 

projector severely damaged.
•	 Do not use the projector where temperatures vary greatly. The projector must be used at temperatures between 

41°F (5°C) and 104°F (40°C) (Eco mode selected automatically at 95°F to 104°F/35°C to 40°C).
•	 Do not expose the projector to moisture, dust, or smoke. This will harm the screen image.
•	 Ensure that you have adequate ventilation around your projector so heat can dissipate. Do not cover the vents on 

the side or the front of the projector.

Reflecting the Image
Using a mirror to reflect your projector’s image enables you to enjoy a much larger image when a smaller space is 
required. Contact your NEC dealer if you need a mirror system. If you’re using a mirror system and your image is 
inverted, use the MENU and ▲▼◀▶ buttons on your projector cabinet or your remote control to correct the orienta-
tion. (→ page 62)
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❷ Making Connections

Connecting Your Computer
Computer cables, HDMI and USB can be used to connect to a computer. The HDMI cable is not enclosed with the 
projector. Please get ready a suitable cable for the connection.

NOTE: Signals supported by Plug & Play (DDC2)

INPUT
COMPUTER IN HDMI 1/MHL IN HDMI 2 IN

analog digital digital
Yes Yes Yes

USB cable (supplied) 
(compatible with USB 2.0 
specifications)

Computer cable (VGA) (supplied)
To mini D-Sub 15-pin terminal on the 
projector. It is recommended that you 
use a commercially available distribu-
tion amplifier if connecting a signal 
cable longer than the cable supplied.

Type B

Type A

Stereo mini-plug audio cable (not supplied)

HDMI cable (not supplied)
Use High Speed HDMI® Cable.

NOTE: For Mac, use a commercially available 
pin adapter (not supplied) to connect to your 
Mac’s video port.

•	 Select the source name for its appropriate input terminal after turning on the projector.

Input terminal SOURCE button on the projector cabinet Button on the remote control

COMPUTER IN  COMPUTER (COMPUTER 1)

HDMI 1/MHL IN  HDMI1/MHL (HDMI 1/MHL*)

HDMI 2 IN  HDMI2 (HDMI 2*)

USB (PC)  USB-B (USB-B)

NOTE: The projector is not compatible with video decoded outputs of the NEC ISS-6020 switcher.
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NOTE: An image may not be displayed correctly when a Video source is played back via a commercially available scan converter. 
This is because the projector will process a video signal as a computer signal at the default setting. In that case, do the following.
*	 When an image is displayed with the lower and upper black portion of the screen or a dark image is not displayed correctly:
	 Project an image to fill the screen and then press the AUTO ADJ. button on the remote control or the projector cabinet.
Enabling the computer’s external display
Displaying an image on the notebook PC’s screen does not necessarily mean it outputs a signal to the projector.
When using a PC compatible laptop, a combination of function keys will enable/disable the external display.
Usually, the combination of the “Fn” key along with one of the 12 function keys gets the external display to come on or off. For 
example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle through external display selections.

Cautions when using a DVI signal
•	 When the computer has a DVI output connector, use a commercially available converter cable to connect the com-

puter to the projector’s HDMI 1/MHL or HDMI 2 input connector (only digital video signals can be input).

NOTE: When Viewing a DVI Digital Signal
•	 Turn off the power of the computer and projector before connecting.
•	 When a video deck is connected via a scan converter, etc., the display may not be correct during fast-forwarding and rewinding.
•	 Use a DVI-to-HDMI cable compliant with DDWG (Digital Display Working Group) DVI (Digital Visual Interface) revision 1.0 stan-

dard.
	 The cable should be within 197"/5 m long.
•	 Turn off the projector and the PC before connecting the DVI-to-HDMI cable.
•	 To project a DVI digital signal: Connect the cables, turn the projector on, then select the HDMI input. Finally, turn on your PC.
	 Failure to do so may not activate the digital output of the graphics card resulting in no picture being displayed. Should this happen, 

restart your PC.
•	 Do not disconnect the DVI-to-HDMI cable while the projector is running. If the signal cable has been disconnected and then 

reconnected, an image may not be correctly displayed. Should this happen, restart your PC.
•	 The COMPUTER video input connectors support Windows Plug and Play.
•	 A Mac signal adapter (commercially available) may be required to connect a Mac computer.
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Connecting an External Monitor

You can connect a separate, external monitor to your projector to simultaneously view on a monitor the computer 
analog image you’re projecting.

NOTE:
•	 The AUDIO OUT mini jack does not support Headphone terminal.
•	 When audio equipment is connected, the projector speaker is disabled.
•	 The signal output from the MONITOR OUT (COMPUTER) of this projector is for projecting image on exclusive one display.
•	 When no signal is applied over 3 minutes in the condition of projector standby when NETWORK STANDBY is set in the Standby 

mode, output from the MONITOR OUT or AUDIO OUT terminal will be stopped. In this case pull out the computer cable and set 
it back after inputting video signal

Monitor out and sleep mode:
•	 The MONITOR OUT (COMP.) connector will not work when [NORMAL] is selected for [STANDBY MODE]. 
	 The MONITOR OUT (COMP.) connector will work only in the sleep mode. 
	 Applying a signal from the COMPUTER IN connector will put the projector in the sleep mode, which allows you to use the MONI-

TOR OUT(COMP.) connector and the AUDIO OUT mini jack. Sound from the MIC input jack will be output to the AUDIO OUT mini 
jack. 

	 The sleep mode is one of the standby modes. The sleep mode cannot be selected from the menu.
•	 In the network standby mode, sound for the last viewed computer or video source will be heard. 
	 BNC-to- COMPUTER IN terminal converted signal will not be output in the standby mode and sleep mode.

Computer 
cable (VGA) 
(supplied)

Stereo mini-plug audio cable (not 
supplied)

Computer cable (VGA) 
(not supplied)

Stereo mini-plug audio 
cable (not supplied)
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Connecting Your DVD Player or Other AV Equipment
Connecting Video Input

•	 Select the source name for its appropriate input terminal after turning on the projector.

Input terminal
SOURCE button on the projector 

cabinet
Button on the remote control

VIDEO IN  VIDEO (VIDEO)

NOTE: Refer to your VCR owner’s manual for more information about your equipment’s video output requirements.

NOTE: An image may not be displayed correctly when a Video source is played back in fast-forward or fast-rewind via a scan converter.

Audio cable (not supplied)Video cable (not supplied)

Audio cable (not supplied)

Audio equipment
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Connecting Component Input

	 A component signal will be automatically displayed. If not, from the menu, select [SETUP] → [OPTIONS(1)] → 
[SIGNAL SELECT] → [COMPUTER], and then place a check mark in the Component radio button.

•	 Select the source name for its appropriate input terminal after turning on the projector.

Input terminal
SOURCE button on the projector 

cabinet
Button on the remote control

COMPUTER IN  COMPUTER (COMPUTER 1)

NOTE: Refer to your DVD player’s owner’s manual for more information about your DVD player’s video output requirements.

15-pin - to - RCA (female) × 3 
cable adapter (ADP-CV1E)

Stereo mini plug - to - RCA audio 
cable (not supplied)

Component video RCA × 
3 cable (not supplied)

Audio cable (not supplied)

DVD player

Audio Equipment
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Connecting HDMI Input
You can connect the HDMI output of your DVD player, hard disk player, Blu-ray player, or notebook type PC to the 
HDMI IN terminal of your projector.

•	 Select the source name for its appropriate input terminal after turning on the projector.

Input terminal
SOURCE button on the projector 

cabinet
Button on the remote control

HDMI 1/MHL IN  HDMI1/MHL (HDMI1/MHL*)

HDMI 2 IN  HDMI2 (HDMI2*)

•	 When connecting the HDMI1/MHL IN terminal (or HDMI2 terminal) of the projector to the DVD player, the projec-
tor’s video level can be made settings in accordance with the DVD player’s video level. In the menu select [HDMI 
SETTINGS] → [VIDEO LEVEL] and make necessary settings.

•	 If the HDMI input sound cannot be heard, in the menu select [AUDIO SELECT] → [HDMI1/MHL] or [HDMI2]. (→ 
page 66)

HDMI cable (not supplied)
Use High Speed HDMI® Cable.

Audio cable (not supplied)
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Connecting a smart phone and a tablet terminal
The below mentioned feature is available when the projector is connected with MHL supported devices such as a 
smart phone and a tablet terminal by a MHL cable (not supplied)

•	 Projecting a image and a file on the MHL supported devices.
•	 Output sound on the MHL supported devices from the build-in speaker.
•	 Charge the MHL supported devices.
•	 Operate the MHL supported devices by the remote control for the projector.
•	 Operate the projector by the MHL supported devices

MHL cable (not supplied)

MHL supported devices

Micro USB cable / to the double use terminal as 
power source

•	 Select the source name for its appropriate input terminal after turning on the projector.

Input terminal
SOURCE button on the projector 

cabinet
Button on the remote control

HDMI 1/MHL IN  HDMI1/MHL (HDMI1/MHL*)

NOTE:
•	 Please use the MHL cable (not supplied) that meets the standard.
	 If the cable that does not meet the standard is used, it may be cause of fire, injury or damage of property around during charging 

the MHL supported devices.
•	 If MHL-HDMI adaptor is used, it may disable to charge/operate the MHL supported devices by the remote control of the projector.
•	 If image can not be projected correctly, pull out the MHL cable once and put it back again.
•	 Depending on types and setting of smart phones and tablets, image may not be projected correctly.

Information
•	 In the below mentioned conditions, the MHL supported devices are not charged

-	 When the projector is in STANDBY mode
-	 When the MHL supported devices are discharged completely.
-	 When supply current is over consumption current.
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Connecting your document camera
You can connect your document camera and project printed documents, etc.

Name, position, and direction of terminals are 
vary depending on camera model. Please check 
user's manual of your camera for details.

Computer cable (VGA)
(supplied)

Video cable (not supplied)

•	 Select the source name for its appropriate input terminal after turning on the projector.

Input terminal
SOURCE button on the projector 

cabinet
Button on the remote control

COMPUTER IN  COMPUTER (COMPUTER 1)

VIDEO IN  VIDEO (VIDEO)

Table projection
Installing the projector in vertical position, it able to project images onto the ceiling, the table and the floor.
Make sure to install the projector with the table projection mount (NP01TK sold separately).
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Connecting to a Wired LAN
The projector comes standard with a LAN port (RJ-45) which provides a LAN connection using a LAN cable. 
To use a LAN connection, you are required to set the wired LAN settings on the projector menu. Select [SETUP] → 
[INSTALLATION] → [NETWORK SETTINGS]. (→ page 64).

Example of LAN connection
Example of wired LAN connection

Server

Hub

LAN cable (not supplied)

NOTE: Use a Category 5 or higher 
LAN cable.
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Connecting to a Wireless LAN (Optional: NP05LM series)
The USB Wireless LAN Unit also provides a wireless LAN connection. To use a wireless LAN connection, you are 
required to assign an IP address to the projector.

Important: 
•	 If you use the projector with the USB Wireless LAN Unit in the area where the use of wireless LAN equipment is prohibited, remove 

the USB Wireless LAN Unit from the projector.
•	 Buy the appropriate USB Wireless LAN Unit for your country or area.

NOTE: 
•	 The green LED on the USB Wireless LAN Unit flashes to show that the USB Wireless LAN Unit is working.
•	 Your computer’s wireless LAN adapter (or unit) must be complied with Wi-Fi (IEEE802.11b/g/n) standard.

Attaching the USB Wireless LAN Unit
NOTE:
•	 The USB Wireless LAN Unit must be inserted into the USB Wireless LAN Unit port in the correct direction. It cannot be inserted 

in the reverse direction. If the USB Wireless LAN Unit is inserted in the reverse direction with excessive force applied, the USB 
port may break.

•	 Before touching the USB Wireless LAN Unit, touch a metallic object (such as a door knob or aluminum window frame) to discharge 
the static electricity from your body.

•	 Always insert or remove the USB Wireless LAN unit when the main power is turned off. Failure to do so may cause projector 
malfunction or damage to the USB wireless LAN unit. If the projector will not work correctly, turn off the projector, disconnect 
the power cord, and then connect it again.

•	 Do not insert other USB devices into the USB Wireless LAN unit port. Do not insert the USB Wireless LAN unit into the USB (PC) 
port (Type B).

NOTE:When the cable cover is attached, remove it before inserting the USB Wireless LAN Unit.

1.	 Press the POWER button to turn off the projector and set it 
into standby condition, and disconnect the power cord.

2.	 Slowly insert the USB Wireless LAN Unit into the USB (WLAN) 
port.

	 Remove the cap from the USB Wireless LAN Unit, and then insert 
it with the surface (side of indicator) facing outward. Keep the cap 
for later use.

NOTE: Do not force to insert the USB Wireless LAN Unit.

*	 To remove the USB Wireless LAN Unit, disconnect the power 
cord and use the above procedure.

NOTE: 
•	 The green LED on the USB Wireless LAN Unit flashes to show that Wireless 

LAN Unit is working. If the USB Wireless LAN Unit is incorrectly attached, 
the blue LED will not flash.

•	 Do not press the button on the USB Wireless LAN Unit. The button will not 
work with this model.
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Example of wireless LAN connection
To use a LAN connection, you are required to set the Wireless LAN settings on the projector menu. Select [SETUP] 
→ [INSTALLATION] → [NETWORK SETTINGS]. (→ page 64).
 

PC with wireless LAN 
card inserted

PC with built-in wireless 
LAN function

Wired LAN

Wireless access point

USB Wireless LAN Unit
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6. APPS MENU
❶ What can you do with the APPS MENU?
It becomes available to select the expansion functions indicated in below and various setting with the APPS MENU.
For displaying the APPS MENU, press the APPS button on the remote or select [APPS] as the [SOURCE] on the 
onscreen menu.
Once calibration for the stylus pen is performed, the stylus pen becomes available for selecting and setting up various 
functions on the APPS MENU.

INFORMATION
Detailed information about each function on the APPS MENU is explained on our web site. Please search it by the 
model name of your projector.
http://www.nec-display.com/dl/en/pj_manual/lineup.html

APPS MENU screen display

Current date and time
Important: 
Before utilizing the func-
tion of APPS MENU, set 
day and time.

REMOTE DESKTOP 
CONNECTION

Miracast

IMAGE EXPRESS UTIL-
ITY LITE

NETWORK INFORMA-
TION

COLLABORATION

WHITEBOARD

FOCUS
Indicating the selected 

item.
Surrounded in a yellow 

square.

VIEWER

NETWORK SETTINGS

TOOLS

WEB SHARING

http://www.nec-display.com/dl/en/pj_manual/lineup.html
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VIEWER
Select the saved images/videos and project them by the projector. This function is available saved data in three stor-
ages explained below:
(1) Projector Memory: Images temporarily saved in the projector built-in memory. (Call “Captured image” in this manual)
(2) USB Memory: Images and videos saved in the USB memory connected with the projector.
(3) Common Folder: Images and videos saved in the common folder in a network connected with the projector.

WHITEBOARD
Enables to perform drawing by the stylus pen supplied with the projector. Before starting the [WHITEBOARD], perform 
the calibration in the [TOOLS] → [PEN SETTINGS].

COLLABORATION
Enables to share the drawing drawn by the stylus pen with the computer connected in a network.

REMOTE DESKTOP CONNECTION
•	 Select the computer connected in the same network with the projector, and the projector projects the images on 

the computer over the network.
	 A commercially available USB keyboard can be used for controlling Windows 8 and Windows 7 computers connected 

in the network with the projector.

IMAGE EXPRESS UTILITY LITE
•	 If various terminal units such as a computer, a smartphone, and a tablet are connected with the projector in the 

network, it enables to transfer images saved on each terminal to the projector and to project them.
•	 You can connect terminal units in multiple OS (Windows, Mac OS, Android, and iOS) with the projector simultane-

ously.
•	 The projector receives images transferred from multiple terminal units (Max. 50 units) and projects them on the 

screen dividing it (Max. 4 × 4) at the same time.

BA C
D E

A B

C D

Transmit Stop

Simultaneous connection

Simultaneous display

•	 Install the application software “Image Express Utility Lite”, included in the CD-ROM supplied with the projector on 
computers. (→ page 94, 97)

•	 For a smartphone and a tablet, download the application “Wireless Image Utility” from our web site and install it on 
these. (→ page 111)

Miracast
By wirelessly connecting the terminal units supporting the Miracast such as the Android with the projector, it enables 
the projector to project images transferred from these terminals.
Before connecting these terminal units, set [Miracast] in the [NETWORK SETTINGS] on the projector.
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WEB SHARING
•	 Without using the exclusive software, it enables to share images and files among the projector and computers in 

the same network by accessing the HTTP server of the projector utilizing the web browser. (WEB SHARING)

BA C D E

Sharing files

•	 It enables to control the projector on the web browser screens on the computers.
•	 Connect the projector and computers in a network and access the URL in below by the web browser of the comput-

ers.
	 URL: http://<IP address of the projector>

NETWORK SETTINGS
Set up below for connecting the projector with a wired/wireless LAN.

PROJECTOR NAME
Set up the host name and domain name of the projector. Serial number of the projector is set as factory default.

NETWORK INFORMATION
Indicate information when the projector has connected in a network (by a wired/wireless LAN)

WIRED LAN
Set up for connecting the projector by a wired LAN.

WIRELESS LAN
Set up for connecting the projector by a wireless LAN. At the same time, set up for the SIMPLE ACCESS POINT, 
Wi-Fi Direct, and Miracast.

IMAGE EXPRESS UTILITY LITE
Set up the MODE (FREE, MANAGED) for the IMAGE EXPRESS UTILITY LITE.

NETWORK SERVICE
Set up various setting for the AMX, HTTP server, PJLink, Alert mail and CRESTRON.

TOOLS
Set up for various features as the stylus pen, mouse, program timer, day and time, administrator mode and default APP.

PEN SETTINGS
For using the stylus pen at the first time or when the projector installation place is changed, make sure to perform 
calibration of the stylus pen for letting the projector to recognize the stylus pen position properly. (→ page 42)

MOUSE
A commercially available USB mouse can be used for operating the APPS MENU. Perform the set up for using it.

PROGRAM TIMER
Once day and time is set up, changing the projector’s condition in powering ON/standby, switching input signals, and 
switching ECO mode can be automatically performed.

DATE AND TIME 
Determine time zone and summer time of your area and set up current date and time.
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ADMINISTRATOR MODE
Selecting the menu mode of the projector, enable/disable to save all set up values of the projector, and set up a 
password for the administrator mode.

DEFAULT APP
Select an application (internal application) performing as default without displaying the APPS MENU either when the 
APPS button on the remote or APPS is selected as the SOURCE on the onscreen menu.
When the projector is turned on in the condition of being selected the “APPS” terminal, the application selected in the 
[DEFAULT APP] will be started automatically.
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❶ Software Included on CD-ROM
Names and Features of Bundled Software Programs

Name of software program Features

Image Express Utility Lite
Image Express Utility Lite for 
Mac OS

•	 This is a software program used to project your computer’s screen over the 
USB cable or the wired/wireless network. The computer cable (VGA) is not 
required. (→ page 40, 93)

•	 This software program can be used to control the power ON/OFF and source 
selection of the projector from your computer.

•	 The Geometric Correction Tool (GCT) function allows you to correct distortion 
of images projected on a curved wall. (→ page 98)

*	 “USB Display” and “GCT” functions are not supported by Mac.

Name of software program Features

PC Control Utility Pro 4
PC Control Utility Pro 5 (for Mac 
OS)

This is a software program used to operate the projector from the computer when 
the computer and the projector are connected with LAN (wired or wireless) or 
a serial cable. (→ page 101)

Name of software program Features

Virtual Remote Tool
(Windows only)

This is a software program used to control the power ON/OFF and source selec-
tion of the projector from your computer by using the supplied computer cable 
(VGA) and others. (→ page 105)

NOTE:
•	 Image Express Utility Lite does not support “Meeting Mode” in Image Express Utility 2.0 supplied with our other models.

Download Service and Operating Environment
Please visit our website about operating environment and download service for each software:
Visit URL: http://www.nec-display.com/dl/en/index.html
Download - Projector → Software & Driver

Name and Features of an application for Android / iOS.
Name of application: 
Wireless Image Utility (Android / iOS)
Features:
By connecting the projector with a smartphone, it enables to transfer photos and documents saved on the smartphone 
and project these on the projector. (→ page 111)
*	 Wireless Image Utility is not contained in the supplied CD-ROM.

http://www.nec-display.com/dl/en/index.html
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❷ Projecting Your Computer’s Screen Image from the 
Projector over a LAN (Image Express Utility Lite)
 
Using Image Express Utility Lite contained on the supplied NEC Projector CD-ROM allows you to send the computer’s 
screen image to the projector over a USB cable or a wired or wireless LAN.
Image Express Utility Lite is a program compatible with Windows.
Image Express Utility Lite for Mac OS is a program compatible with Mac OS. (→ page 97)
This section will show you an outline about how to connect the projector to a LAN and to use Image Express Utility 
Lite. For the operation of Image Express Utility Lite, see the help of Image Express Utility Lite.

Step 1: install Image Express Utility Lite on the computer. 
Step 2: Connect the projector to a LAN.
Step 3: Start Image Express Utility Lite.

TIP:
•	 Image Express Utility Lite (for Windows) can be started from most commercially available removable media such as USB memory 

devices or SD cards without the need to install on your computer. (→ page 96)

What You can Do with Image Express Utility Lite

Image transmission (for Windows and Mac OS)
•	 The screen of your computer can be sent to the projector via a wired or wireless network without a computer cable 

(VGA).

Audio transfer capability (for Windows only)
•	 Image Express Utility Lite allows you to send the computer's screen image and audio to the projector over wired/

wireless LAN or USB connection.

•	 Audio transfer capability is available only when the computer connects with the projector in peer-to-peer network.

USB Display (for Windows only)
•	 Computer’s screen image can be projected via a USB cable, without connecting a computer cable (VGA).

•	 Just connecting the computer and the projector over a USB cable will make the USB Display function available 
(Plug & Play) even without installing Image Express Utility Lite on the computer. (→ page 40)

Geometric Correction Tool [GCT] (for Windows only)
See “❸ Projecting an Image from an Angle (Geometric Correction Tool in Image Express Utility Lite)”. (→ page 98)
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Using on Windows

Step 1: install Image Express Utility Lite on the computer. 

NOTE:
•	 To install or uninstall the program, the Windows user account must have “Administrator” privilege. 
•	 Exit all running programs before installation. If another program is running, the installation may not be completed. 
•	 Image Express Utility Lite will be installed to the system drive of your computer.
	 If the message “There is not enough free space on destination” is displayed, free up enough space (about 100 MB) to install the 

program.

1.	 Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.

	 The menu window will be displayed.

TIP:
If the menu window will not be displayed, try the following procedure.
For Windows 7:
1. Click “start” on Windows.

2. Click “All Programs” → “Accessories” → “Run”.

3.	 Type your CD-ROM drive name (example: “Q:\”) and “LAUNCHER.EXE” in “Name”. (example: Q:\LAUNCH-
ER.EXE)

4.	 Click “OK”.

	 The menu window will be displayed.

2.	 Click “Installing Image Express Utility Lite” on the menu window.

	 The installation will start.

	 “END USER LICENSE AGREEMENT” screen will be displayed. 

	 Read “END USER LICENSE AGREEMENT” carefully 

3.	 If you agree, click “I agree.” and then click “Next”. 

•	 Follow the instructions on the installer screens to complete the installation. 

•	 When the installation is complete, you will return to the menu window.

	 When the installation is complete, a completion message will be displayed.

4.	 Click “OK”.

	 This completes the installation.

TIP:
• Uninstalling Image Express Utility Lite
To uninstall Image Express Utility Lite, do the same procedures stated as in “Uninstalling Virtual Remote Tool”. Read “Virtual Remote 
Tool” as “Image Express Utility Lite” (→ page 108)
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Step 2: Connect the projector to a LAN.
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 85) and “Con-
necting to a Wireless LAN (Optional: NP05LM series)” (→ page 86).

Step 3: Start Image Express Utility Lite.
1.	 On Windows, click “Start” → “All programs” → “NEC Projector UserSupportware” → “Image Express Utility 

Lite” → “Image Express Utility Lite”.

	 Image Express Utility Lite will start.

	 The select window for network connection will be displayed

2.	 Select Network and click “OK”.

	 The select window for destination will show a list of connectable projectors.

•	 When connecting the computer directly to the projector by one-to-one, “Simple Access Point” is recommended.

•	 To check for the network available for connected projectors, from the menu, select [INFO.] → [WIRELESS LAN] 
→ [SSID].

3.	 Place a check mark for projectors to be connected, and then click “Connect”.

•	 When one or more projectors are displayed, from the menu on the projector, select [INFO.] → [WIRELESS LAN] 
→ [IP ADDRESS].

	 When connecting with the projector is established, you can operate the control window to control the projector. (→ 
page 41)

NOTE:
•	 When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector that is turned off will not be displayed in the 

select window for destination
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TIP:
Viewing the “Help” file of Image Express Utility Lite
•	 Displaying the Help file of Image Express Utility Lite while it is running.

	 Click the [?] (help) icon on the control window.

	 The Help screen will be displayed.

•	 Displaying the Help file of GCT while it is running.

	 Click “Help” → “Help” on the edit window.

	 The Help screen will be displayed.

•	 Displaying the help file using the Start Menu.

	 Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “Image Express Utility Lite” 
→ “Image Express Utility Lite Help”.

	 The Help screen will be displayed.

Starting Image Express Utility Lite from a USB Memory or SD Card
Image Express Utility Lite can be started from commercially available removable media such USB memory or SD 
cards if it is copied beforehand. This will eliminate the trouble of installing Image Express Utility Lite to your computer.
1.	 Copy Image Express Utility Lite to removable media.

	 Copy all the folders and files (total size approx. 7 MB) from the “IEU_Lite (removable-media)” folder in the supplied 
NEC Projector CD-ROM to the root directory of your removable media.

2.	 Insert your removable media into your computer.

	 The “AutoPlay” screen will be displayed on your computer.

TIP: 
•	 If the “AutoPlay” screen is not displayed, open the folder from “Computer” (“My Computer” for Windows XP).

3.	 Click “Open folder to view files”

	 The IEU_Lite.exe, other folder, and files will be displayed.

4.	 Double-click the “IEU_Lite.exe” (  ) icon.

	 Image Express Utility Lite will start.
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Using on Mac OS

Step 1: Install Image Express Utility Lite for Mac OS on the computer
1.	 Insert the accompanying NEC Projector CD-ROM in your Mac CD-ROM drive.

	 The CD-ROM icon will be displayed on the desktop.

2.	 Double-click the CD-ROM icon.

	 The CD-ROM window will be displayed.

3.	 Double-click the “Mac OS X” folder.

4.	 Double-click “Image Express Utility Lite.dmg”.

	 The “Image Express Utility Lite” window will be displayed.

5.	 Drag and drop the “Image Express Utility Lite” folder to your Applications folder in Mac OS.

Step 2: Connect the projector to a LAN
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 85) and “Con-
necting to a Wireless LAN (Optional: NP05LM series)” (→ page 86).

Step 3: Start Image Express Utility Lite for Mac OS
1.	 Open your Applications folder in Mac OS.

2.	 Double-click the “Image Express Utility Lite” folder.

3.	 Double-click the “Image Express Utility Lite” icon.

	 When Image Express Utility Lite for Mac OS starts, the select window for destination will be displayed.

•	 At the first time of startup, “END USER LICENSE AGREEMENT” screen will be displayed before the select 
window for destination is displayed.

	 Read “END USER LICENSE AGREEMENT” and select “I accept the terms in the license agreement”, and click 
“OK”.

4.	 Select a projector to be connected, and then click “Connect”.

	 Your desktop screen will be displayed on the projector.

TIP:
Viewing the Help of Image Express Utility Lite for Mac OS 
•	 From the menu bar, click “Help” → “Image Express Utility Lite Help” while Image Express Utility is running. 

	 The Help screen will be displayed
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❸ Projecting an Image from an Angle (Geometric Correction 
Tool in Image Express Utility Lite)
The Geometric Correction Tool (GCT) function allows you to correct distortion of images projected even from an angle. 

What you can do with GCT

•	 The GCT feature includes the following three functions

•	 4-point Correction: You can fit a projected image within the border of the screen easily by align the four corners 
of an image to the ones of the screen.

•	 Multi-point Correction: You can correct a distorted image on the corner of a wall or irregular shaped screen 
by using many separated screens to correct the image as well as 4-point Correction.

•	 Parameters Correction: You can correct a distorted image by using a combination of transformational rules 
prepared in advance.

This section will show an example for use with 4-point Correction.
For information about “Multi-point Correction” and “Parameters Correction”, see the help file of Image Express 
Utility Lite. (→ page 96, 97) 

•	 Your correction data can be stored in the projector or your computer which can be restored when necessary.

•	 The GCT function is available with a USB cable, wired or wireless LAN connection, and video cable. 

Projecting an Image from an Angle (GCT)
This section will show an example for use with USB Display (using a USB cable to connect a computer and the projector).
•	 The USB Display function will automatically display the control window 

•	 For a video cable or LAN connection, install and start Image Express Utility Lite in your computer beforehand. (→ 
page 93)

Preparation: Adjust the projector position or the zoom so that the projected image can cover the whole screen area.

1.	 Click the “   ” (Others) icon and then the “   ” (Options) 
button.

	 Options window will be displayed.

2.	 Click the check box “Use the multiple connection feature” and 
then clear the check mark.

3.	 Click the “OK” button.
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4.	 Click the “ ”(Projection) icon and then the “    ”(Exit) 
button.

5.	 Click “Yes”.

6.	 Start the Image Express Utility Lite again.

7.	 Click the “   ” (Picture) icon and then the “   ” button.

	 The “4-point Correction” window will be displayed.

8.	 Click the “Start Correction” button and then “Start 4-point 
Correction” button.

	 A green frame and a mouse pointer (   ) will be displayed.

•	 Four [ • ] marks will be appeared at four corners of the green 
frame

9.	 Use the mouse to click the [ • ] mark of which corner you wish 
to move.

	 The currently selected [ • ] mark will turn red.

(In the above example, Windows screens are omitted for clarification.)
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10.	Drag the selected [ • ] mark to the point you wish to correct 
and drop it.

•	 When you click somewhere within the project image area, the 
nearest [ • ] mark will go to the position where the mouse cur-
sor is.

11.	Repeat Step 9 and 10 to correct the distortion of the projected 
image.

12.	After completing, right-click the mouse.

	 The green frame and the mouse pointer will disappear from the 
projected image area. This will complete the correction.

13.	Click the “X” (close) button on the “4-point Correction” window.

	 The “4-point Correction” window will disappear and the 4-point 
correction will take effect.

14.	Click the “   ” button on the control window to exit the GCT.

TIP:
•	 After performing the 4-point correction, you can save the 4-point correction data to the projector by clicking “File” → “Export to 

the projector…” on the “4-point Correction” window.
•	 See the Help of Image Express Utility Lite for operating “4-point Correction” window and other functions than GCT. (→ page 96, 

97)
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❹ Controlling the Projector over a LAN (PC Control Utility Pro 4/
Pro 5)
Using the utility software “PC Control Utility Pro 4” and “PC Control Utility Pro 5” included on the companion NEC 
Projector CD-ROM, the projector can be controlled from a computer over a LAN.
PC Control Utility Pro 4 is a program compatible with Windows. (→ this page)
PC Control Utility Pro 5 is a program compatible with Mac OS. (→ page 104)

Control Functions
Power On/Off, signal selection, picture freeze, picture mute, audio mute, adjusting, error message notification, 
event schedule.

Screen of PC Control Utility Pro 4

This section provides an outline of preparation for use of PC Control Utility Pro 4/Pro 5. For information on how to use 
PC Control Utility Pro 4/Pro 5, see Help of PC Control Utility Pro 4/Pro 5. (→ page 103, 104)

Step 1: Install PC Control Utility Pro 4/Pro 5 on the computer.
Step 2: Connect the projector to a LAN.
Step 3: Start PC Control Utility Pro 4/Pro 5.

•	 To run PC Control Utility Pro 4 on Windows 8.1, Windows 8 and Windows XP, “Microsoft .NET Framework Version 
2.0” is required. The Microsoft .NET Framework Version 2.0, 3.0 or 3.5 is available from Microsoft’s web page. 
Download and install it on your computer.

TIP:
•	 PC Control Utility Pro 4 can be used with a serial connection.

Using on Windows

Step 1: Install PC Control Utility Pro 4 on the computer

NOTE:
•	 To install or uninstall the program, the Windows user account must have [Administrator] privilege.
•	 Exit all running programs before installation. If another program is running, the installation may not be completed.

1	 Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.

	 The menu window will be displayed.
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TIP:
If the menu window will not be displayed, try the following procedure.
For Windows 7:
1.	 Click “start” on Windows.

2.	 Click “All Programs” → “Accessories” → “Run”.

3.	 Type your CD-ROM drive name (example: “Q:\”) and “LAUNCHER.EXE” in “Name”. (example: Q:\
LAUNCHER.EXE)

4.	 Click “OK”.

	 The menu window will be displayed.

2	 Click “PC Control Utility Pro 4” on the menu window.

	 The installation will start.

	 When the installation is complete, the Welcome window will be displayed.

3	 Click “Next”.

	 “END USER LICENSE AGREEMENT” screen will be displayed.

	 Read “END USER LICENSE AGREEMENT” carefully.

4	 If you agree, click “I accept the terms in the license agreement” and then click “Next”.

•	 Follow the instructions on the installer screens to complete the installation.

•	 When the installation is complete, you will return to the menu window.

TIP:
• Uninstalling PC Control Utility Pro 4
To uninstall PC Control Utility Pro 4, do the same procedures stated as in “Uninstalling Virtual Remote Tool”. Read “Virtual Remote 
Tool” as “PC Control Utility Pro 4” (→ page 108)
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Step 2: Connect the projector to a LAN.
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 85) and “Con-
necting to a Wireless LAN (Optional: NP05LM series)” (→ page 86).

Step 3: Start PC Control Utility Pro 4
Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → 
“PC Control Utility Pro 4”.

NOTE: 
•	 For the Schedule function of the PC Control utility Pro 4 to work, you must have your computer running and not in standby/

sleep mode. Select “Power Options” from the “Control Panel” in Windows and disable its standby/sleep mode before running the 
scheduler.

[Example] For Windows 7:
Select “Control Panel” → “System and Security” → “Power Options” → “Change when the computer sleeps” → “Put the computer 
to sleep” → “Never”. 
NOTE: 
•	 When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the network (wired LAN/

wireless LAN) connection.

TIP:

Viewing the Help of PC Control Utility Pro 4
•	 Displaying the Help file of PC Control Utility Pro 4 while it is running.

	 Click “Help (H)” → “Help (H) …” of window of PC Control Utility Pro 4 in this order.

	 The pop-up menu will be displayed.

•	 Displaying the help file using the Start Menu.

	 Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → 
“PC Control Utility Pro 4 Help”.

	 The Help screen will be displayed.
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Using on Mac OS

Step 1: Install PC Control Utility Pro 5 on the computer
1.	 Insert the accompanying NEC Projector CD-ROM in your Mac CD-ROM drive.

	 The CD-ROM icon will be displayed on the desktop.

2.	 Double-click the CD-ROM icon.

	 The CD-ROM window will be displayed.

3.	 Double-click the “Mac OS X” folder.

4.	 Double-click “PC Control Utility Pro 5.pkg”.

	 The installer will start.

5.	 Click “Next”.

	 “END USER LICENSE AGREEMENT” screen will be displayed.

6.	 Read “END USER LICENSE AGREEMENT” and click “Next”.

	 The confirmation window will be displayed

7.	 Click “I accept the terms in the license agreement”.

	 Follow the instructions on the installer screens to complete the installation.

Step 2: Connect the projector to a LAN
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 85) and “Con-
necting to a Wireless LAN (Optional: NP05LM series)” (→ page 86).

Step 3: Start PC Control Utility Pro 5
1.	 Open your Applications folder in Mac OS.

2.	 Click the “PC Control Utility Pro 5” folder.

3.	 Click the “PC Control Utility Pro 5” icon.

	 PC Control Utility Pro 5 will start.

NOTE: 
•	 For the Schedule function of the PC Control utility Pro 5 to work, you must have your computer running and not in sleep mode. 

Select “Energy Saver” from the “System Preferences” in Mac and disable its sleep mode before running the scheduler.
•	 When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the network (wired LAN/

wireless LAN) connection.
 
TIP:

Viewing the Help of PC Control Utility Pro 5
• Displaying the Help file of PC Control Utility Pro 5 while it is running. 
•	 From the menu bar, click “Help” → “Help” in this order. 

	 The Help screen will be displayed.

• Displaying the Help using the Dock 
1.	 Open “Application Folder” in Mac OS.

2.	 Click the “PC Control Utility Pro 5” folder.

3.	 Click the “PC Control Utility Pro 5 Help” icon.

	 The Help screen will be displayed.
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❺ Using the Computer Cable (VGA) to Operate the 
Projector (Virtual Remote Tool)
Using the utility software “Virtual Remote Tool” included on the companion NEC Projector CD-ROM, Virtual Remote 
screen (or toolbar) can be displayed on your computer screen.
This will help you perform operations such as projector’s power on or off and signal selection via the computer cable 
(VGA), serial cable, or LAN connection. Only via serial or LAN connection it is also used to send an image to the projec-
tor and register it as the logo data of the projector. After registering it, you can lock the logo to prevent it from changing.

Control Functions
Power On/Off, signal selection, picture freeze, picture mute, audio mute, Logo transfer to the projector, and remote 
control operation on your PC.

Virtual Remote screen Toolbar

This section provides an outline of preparation for use of Virtual Remote Tool.
For information on how to use Virtual Remote Tool, see Help of Virtual Remote Tool. (→ page 110)

Step 1: Install Virtual Remote Tool on the computer. (→ page 106)
Step 2: Connect the projector to the computer. (→ page 108)
Step 3: Start Virtual Remote Tool. (→ page 109)

TIP:
•	 Virtual Remote Tool can be used with a LAN and a serial connection. USB connection is not supported by Virtual Remote Tool.
•	 For update information on Virtual Remote Tool, visit our website: 
	 http://www.nec-display.com/dl/en/index.html

http://www.nec-display.com/dl/en/index.html
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NOTE:
•	 When [COMPUTER] is selected from your source selection, the Virtual Remote screen or the toolbar will be displayed as well as 

your computer screen.
•	 Use the supplied computer cable (VGA) to connect the COMPUTER IN terminal directly with the monitor output terminal of the 

computer to use Virtual Remote Tool.
	 Using a switcher or other cables than the supplied computer cable (VGA) may cause failure in signal communication.
	 VGA cable terminal:
	 Pin Nos. 12 and 15 are required for DDC/CI.
•	 Virtual Remote Tool may not work depending on your computer’s specifications and version of graphic adapters or drivers.
•	 To run Virtual Remote Tool on Windows 8.1 and Windows 8, “Microsoft .NET Framework Version 2.0” is required. The Microsoft 

.NET Framework Version 2.0, 3.0 or 3.5 is available from Microsoft’s web page. Download and install it on your computer.
•	 Logo data (graphics) that can be sent to the projector with Virtual Remote Tool has the following restrictions: 
	 (Only via serial or LAN connection)

-	 File size: Less than 1 MB
-	 Image size (resolution): 
	 Horizontal 1280 × vertical 800 dots or less
-	 Number of colors: 256 colors or less

•	 To put the default "NEC logo" back in the background logo, you need to register it as the background logo by using the image file 
(/Logo/necpj_bbwx.bmp)inclulded on the supplied NEC Projector CD-ROM.

TIP:
•	 The projector’s COMPUTER IN terminal supports DDC/CI (Display Data Channel Command Interface). DDC/CI is a standard 

interface for bidirectional communication between display/projector and computer.

Step 1: Install Virtual Remote Tool on the computer

NOTE:
•	 To install Virtual Remote Tool, the Windows user account must have “Administrator” privilege. 
•	 Exit all running programs before installing Virtual Remote Tool. If another program is running, the installation may not be com-

pleted. 

1	 Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.

	 The menu window will be displayed.

TIP:
If the menu window will not be displayed, try the following procedure.
For Windows 7
1.	 Click “start” on Windows.

2.	 Click “All Programs” → “Accessories” → “Run”.

3.	 Type your CD-ROM drive name (example: “Q:\”) and “LAUNCHER.EXE” in “Name”. (example: Q:\
LAUNCHER.EXE)

4.	 Click “OK”.

	 The menu window will be displayed.
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2	 Click “Install Virtual Remote Tool” on the menu window.

	 The installation will start.

	 When the installation is complete, the Welcome window will be displayed.

3	 Click “Next”.

	 “END USER LICENSE AGREEMENT” screen will be displayed.

	 Read “END USER LICENSE AGREEMENT” carefully.

4	 If you agree, click “I accept the terms in the license agreement” and then click “Next”.

•	 Follow the instructions on the installer screens to complete the installation.

•	 When the installation is complete, you will return to the menu window.
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TIP:

Uninstalling Virtual Remote Tool
Preparation:
Exit Virtual Remote Tool before uninstalling. To uninstall Virtual Remote Tool, the Windows user account must have 
“Administrator” privilege (Windows 8.1, Windows 8, Windows 7 and Windows Vista) or “Computer Administrator” 
privilege (Windows XP).

• For Windows 8.1, Windows 8, Windows 7 and Windows Vista
1	 Click “Start” and then “Control Panel”.

	 The Control Panel window will be displayed.

2	 Click “Uninstall a program” under “Programs”

	 The “Programs and Features” window will be displayed.

3	 Select Virtual Remote Tool and click it.

4	 Click “Uninstall/Change” or “Uninstall”.

	 • When the “User Account Control” windows is displayed, click “Continue”.

	 Follow the instructions on the screens to complete the uninstallation.

Step 2: Connect the projector to the computer
1	 Use the supplied computer cable (VGA) to connect the COMPUTER IN terminal of the projector directly 

with the monitor output terminal of the computer.

2	 Connect the supplied power cord to the AC IN of the projector and the wall outlet.

	 The projector is in the standby condition.

AC Input

Supplied computer cable (VGA)

→ To wall outlet
Power cord (supplied)

TIP:
•	 When Virtual Remote Tool starts for the first time, “Easy Setup” window will be displayed to navigate your connections.
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Step 3: Start Virtual Remote Tool

Start using the shortcut icon
•	 Double-click the shortcut icon  on the Windows Desktop.

Start from the Start menu
•	 Click [Start] → [All Programs] or [Programs] → [NEC Projector User Supportware] → [Virtual Remote Tool] 

→ [Virtual Remote Tool].

	 When Virtual Remote Tool starts for the first time, “Easy Setup” window will be displayed.

	 Follow the instructions on the screens

	 When “Easy Setup” is completed, the Virtual Remote Tool screen will be displayed.

NOTE:
•	 When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the computer cable 

(VGA) or network (wired LAN/wireless LAN) connection.

TIP:
•	 The Virtual Remote Tool screen (or Toolbar) can be displayed without displaying “Easy Setup” window.
	 To do so, click to place a check mark for “  Do not use Easy Setup next time” on the screen at Step 6 in “Easy Setup”.
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Exiting Virtual Remote Tool
1	 Click the Virtual Remote Tool icon  on the Taskbar.

	 The pop-up menu will be displayed.

2	 Click “Exit”.

	 The Virtual Remote Tool will be closed.

Viewing the help file of Virtual Remote Tool
• Displaying the help file using the taskbar
1	 Click the Virtual Remote Tool icon  on the taskbar when Virtual Remote Tool is running.

	 The pop-up menu will be displayed.

2.	 Click “Help”.

	 The Help screen will be displayed.

• Displaying the help file using the Start Menu.
1.	 Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “Virtual Remote 

Tool” → and then “Virtual Remote Tool Help” in this order.

	 The Help screen will be displayed.
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❻ Projecting photos or documents saved on the smartphone 
over a wireless LAN (Wireless Image Utility)
Utilizing the Wireless Image Utility, it enables to transfer photos and documents saved on terminals as a smartphone 
or a tablet to the projector via the wireless LAN and project them.
There are two kinds of Wireless Image Utility software one for Android and another for iOS that can be downloaded 
from Google Play or App Store.

For Android
http://www.nec-display.com/dl/en/pj_android/wiu_for-android.html

For iOS
http://www.nec-display.com/dl/en/pj_ios/wiu_for-ios.html

http://www.nec-display.com/dl/en/pj_android/wiu_for-android.html
http://www.nec-display.com/dl/en/pj_ios/wiu_for-ios.html
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This section describes the simple maintenance procedures you should follow to clean the filters, the projection window, 
the cabinet, and to replace the lamp and the filters.

❶ Cleaning the Filters
The air-filter sponge keeps dust and dirt from getting inside the projector and should be frequently cleaned. If the filter 
is dirty or clogged, your projector may overheat.

 WARNING
•	 Do not use a spray containing flammable gas to get rid of accumulated dust and dirt on the filters. It may cause 

of fire.

NOTE: The message for filter cleaning will be displayed for one minute after the projector is turned on or off. When the message is 
displayed, clean the filters. The time to clean the filters is set to [5000 H] at time of shipment.
To cancel the message, press any button on the projector cabinet or the remote control.

The two-layer filter on the projector improves cooling and dust-proof capabilities.
The outsides (intake side) of the first and second layer filters remove dust.
To clean the filter, detach the filter unit and the filter cover.

 CAUTION
•	 Before cleaning the filters, turn off the projector, disconnect the power cord and then allow the cabinet to cool. 

Failure to do so can result in electric shock or burn injuries.

1.	 Push the button rightward to release the filter cover and pull 
it out.

Button

2.	 Remove the two filter cases.

Small filter case Large filter case

Tab

Tab

8. Maintenance
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3.	 Remove the four filters and use a vacuum cleaner to vacuum 
all the dust inside and outside.

	 Get rid of dust in the sponge filter

NOTE: 
•	 Whenever you vacuum the filter, use the soft brush attachment to 

vacuum. This is to avoid damage to the filter.
•	 Do not wash the filter with water. Doing so can result in filter clogging.

4.	 Remove dust from the filter cover and the two filter cases 
(large and small).

	 Clean both outside and inside.

5.	 Attach the four filters to two filter cases (large and small).

•	 Attach the coarse-texture sponge filter to the outside of filter 
case. 

	 The coarse-texture sponge filter has slits on it. Align these slits 
with the protrusions of the filter case.

•	 Attach the fine-texture sponge filter to the inside of the filter case.

Slit

Slit
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6.	 Insert the large filter case into the projector cabinet.

	 Make sure that the filter case is inserted in the correct orientation.

7.	 Put the small filter case to the projector cabinet.

	 Make sure that the filter case is inserted in the correct orientation.

8.	 Put the filter cover back to the projector cabinet.

	 Insert two catches of the tip of the filter cover into the groove of the 
cabinet, and push the button to close the filter cover.

•	 If you find it to hard to close the filter cover, try pushing the hook.

Button

Hook

Catch
Inside rib  
(protrusion)

9.	 Clear the filter usage hours.

	 Plug the power cord into the wall outlet, and then turn on the pro-
jector.

	 From the menu, select [RESET] → [CLEAR FILTER HOURS]. (→ 
page 74)

	 The interval time to clean the filters is set to [OFF] at time of ship-
ment. When using the projector as it is, you do not clear the filter 
usage 
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❷ Cleaning the Projection Window
•	 Turn off the projector before cleaning.
•	 Do not scratch or mar the projection window as it is made of glass.
•	 Use a blower or lens paper to clean the projection window, and be careful not to scratch or mar the glass surface.

 WARNING
•	 Do not use a spray containing flammable gas to get rid of accumulated dust and dirt on the projection window. 

It may cause of fire.

❸ Cleaning the Cabinet
Turn off the projector, and unplug the projector before cleaning.
•	 Use a dry soft cloth to wipe dust off the cabinet.

	 If heavily soiled, use a mild detergent. 

•	 Never use strong detergents or solvents such as alcohol or thinner. 

•	 When cleaning the vents or the speaker using a vacuum cleaner, do not force the brush of the vacuum cleaner 
into the slits of the cabinet.

Vacuum the dust off the vents.

•	 Clogged vents may cause a rise in the internal temperature of the projector, resulting in malfunction.
•	 Do not scratch or hit the cabinet with your fingers or any hard objects
•	 Contact your dealer for cleaning the inside of the projector.

NOTE: Do not apply volatile agent such as insecticide on the cabinet, the projection window, or the screen. Do not leave a rubber 
or vinyl product in prolonged contact with it. Otherwise the surface finish will be deteriorated or the coating may be stripped off. 
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❹ Replacing the Lamp and the Filters
When the lamp reaches the end of its life, the LAMP indicator in the cabinet will blink red and the message “THE 
LAMP HAS REACHED THE END OF ITS USABLE LIFE. PLEASE REPLACE THE LAMP AND FILTER.” will appear 
(*). Even though the lamp may still be working, replace the lamp to maintain the optimal projector performance. After 
replacing the lamp, be sure to clear the lamp hour meter. (→ page 74)

 CAUTION
•	 DO NOT TOUCH THE LAMP immediately after it has been used. It will be extremely hot. Turn the projector off 

and then disconnect the power cord. Allow at least one hour for the lamp to cool before handling.

•	 Use the specified lamp for safety and performance. 

	 To order the replacement lamp, specify your lamp type.

	 Replacement lamp:

	 NP33LP

	 The replacement lamp comes with filters. While the filters attached to the projector at the time of purchase are 
made of dark sponge material, the filters included with the optional lamp are made of non-woven white material. 
There is no difference in performance between these two types.

•	 DO NOT REMOVE ANY SCREWS except one lamp cover screw and two lamp housing screws. You could receive 
an electric shock.

•	 Do not break the glass on the lamp housing.

	 Keep finger prints off the glass surface on the lamp housing. Leaving finger prints on the glass surface might cause 
an unwanted shadow and poor picture quality.

•	 The projector will turn off and go into standby mode when you continue to use the projector for another 100 hours 
after the lamp has reached the end of its life. If this happens, be sure to replace the lamp. If you continue to use 
the lamp after the lamp reaches the end of its life, the lamp bulb may shatter, and pieces of glass may be scattered 
in the lamp case. Do not touch them as the pieces of glass may cause injury. If this happens, contact your NEC 
dealer for lamp replacement.

*NOTE: This message will be displayed under the following conditions:
•	 for one minute after the projector has been powered on
•	 when the  (POWER) button on the projector cabinet or the STANDBY button on the remote control is pressed

To turn off the message, press any button on the projector cabinet or the remote control.

Optional lamp and tools needed for replacement:

•	 Phillips screwdriver (plus-head)

•	 Replacement lamp

Flow of Replacing the Lamp and the Filters

Step 1.	 Replace the lamp 

Step 2.	 Replace the filters (→ page 119)

Step 3.	 Clear the lamp usage hours and the filter usage hours (→ page 74)
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2.	 Remove the lamp housing.

(1)	Loosen the two screws securing the lamp housing until the phillips screwdriver goes into a freewheeling condi-
tion.

•	 The two screws are not removable.

•	 There is an interlock on this case to prevent the risk of electrical shock. Do not attempt to circumvent this 
interlock.

(2)	Remove the lamp housing by holding it.

 CAUTION:
Make sure that the lamp housing is cool enough to before removing it.

To replace the lamp: 
1.	 Remove the lamp cover.

(1)	Loosen the lamp cover screw

•	 The lamp cover screw is not removable.

(2)	Push and slide the lamp cover off.

a b

Interlock
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This completes the lamp replacement.
Go on to the filter replacement.

NOTE: When you continue to use the projector for another 100 hours after the lamp has reached the end of its life, the projector 
cannot turn on and the menu is not displayed.
If this happens, press the HELP button on the remote control for 10 seconds to reset the lamp clock back to zero.
When the lamp time clock is reset to zero, the LAMP indicator goes out.
 

4.	 Reattach the lamp cover.

(1)	Slide the lamp cover back until it snaps into place.

(2)	Tighten the screw to secure the lamp cover.

•	 Be sure to tighten the screw.

3.	 Install a new lamp housing.

(1)	Insert a new lamp housing until the lamp housing is plugged into the socket. 

(2)	Push the top center of the lamp housing to secure it.

(3)	Secure it in place with the two screws.

•	 Be sure to tighten the screws.

a

b
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To replace the filters:

NOTE: 
•	 Replace all four filters at the same time.
•	 Before replacing the filters, wipe off dust and dirt from the projector cabinet. 
•	 The projector is precision equipment. Keep out dust and dirt during filter replacement.
•	 Do not wash the filters with soap and water. Soap and water will damage the filter membrane. 
•	 Put filters into place. Incorrect attachment of a filter may cause dust and dirt to get into the inside of the projector. 

Before replacing the filters, replace the lamp. (→ page 116)

1.	 Push the button rightward to release the filter cover and pull 
it out.

Button

2.	 Remove the two filter cases.

Small filter case Large filter case

Tab

Tab
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3.	 Remove the four filters and use a vacuum cleaner to vacuum 
all the dust inside and outside.

	 Get rid of dust in the sponge filter

NOTE: 
•	 Whenever you vacuum the filter, use the soft brush attachment to 

vacuum. This is to avoid damage to the filter.
•	 Do not wash the filter with water. Doing so can result in filter clogging.

4.	 Remove dust from the filter cover and the two filter cases 
(large and small).

	 Clean both outside and inside.

5.	 Attach the four filters to two filter cases (large and small).

•	 Attach the coarse-texture sponge filter to the outside of filter 
case. 

	 The coarse-texture sponge filter has slits on it. Align these slits 
with the protrusions of the filter case.

•	 Attach the fine-texture sponge filter to the inside of the filter case.

Slit

Slit
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6.	 Insert the large filter case into the projector cabinet.

	 Make sure that the filter case is inserted in the correct orientation.

7.	 Put the small filter case to the projector cabinet.

	 Make sure that the filter case is inserted in the correct orientation.

8.	 Put the filter cover back to the projector cabinet.

	 Insert two catches of the tip of the filter cover into the groove of the 
cabinet, and push the button to close the filter cover.

•	 If you find it to hard to close the filter cover, try pushing the hook.

Button

Hook

Catch
Inside rib  
(protrusion)

This completes the filter replacement.
Go on to the clearing lamp and filter hour meters.

To clear the lamp usage hours and the filter usage hours:
1.	 Place the projector where you use it.

2.	 Plug the power cord into the wall outlet, and then turn on the projector.

3.	 Clear the lamp usage hours and the filter usage hours.

1.	 From the menu, select [RESET] → [CLEAR LAMP HOURS] and reset the lamp usage hours.

2.	 Select [CLEAR FILTER HOURS] and reset the filter usage hours. (→ page 74)
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❶ Troubleshooting
This section helps you resolve problems you may encounter while setting up or using the projector.
Indicator Messages
Power Indicator

Indicator Condition Projector Condition Note
Off The main power is off –

Blinking 
light

Blue 0.5 sec On,
0.5 sec Off

The projector is getting ready to turn on. Wait for a moment.

2.5 sec On,
0.5 sec Off

Off Timer is enabled. 
Program timer (off time enabled)

–

Orange (short flashes) Cooling Wait for a moment
Orange (long flashes) Program timer (on time enabled)

Steady 
light

Blue The projector is turned on. –
Orange In Standby condition [NETWORK STAND-

BY] is selected for [STANDBY MODE]
–

Red In Standby condition [NORMAL] is 
selected for [STANDBY MODE]

–

Status Indicator
Indicator Condition Projector Condition Note

Off Normal or Standby –
Blinking 
light

Red 1 cycle (0.5 sec 
On, 2.5 sec Off)

Lamp cover error or lamp housing error Mount the lamp cover or lamp housing correctly.

2 cycle (0.5 sec 
On, 0.5 sec Off)

Temperature error The projector is overheated. Move the projector to a 
cooler location.

3 cycle (0.5 sec 
On, 0.5 sec Off)

Power error Power unit is not working properly. Contact your dealer.

4 cycle (0.5 sec 
On, 0.5 sec Off)

Fan error Fans will not work correctly.

6 cycle (0.5 sec 
On, 0.5 sec Off)

Lamp error Lamp fails to light. Wait a full minute and then turn on 
again.

Orange 1 cycle (0.5 sec 
On, 2.5 sec Off)

Network conflict Both the built-in wired LAN and the wireless LAN cannot 
be connected to the same network at the same time.
To use both built-in wired LAN and wireless LAN at the 
same time, connect them to different networks.
NOTE: In the Standby condition, the status indicator 
on the cabinet does not blink in orange even if the 
network conflicts

Green Re-firing the lamp (The projector is cool-
ing down.)

The projector is re-firing.
Wait for a moment.

Steady 
light

Green Sleep mode –
Orange CONTROL PANEL LOCK is on. You have pressed cabinet button when Control Panel 

Lock is on.
CONTROL ID error Remote control ID and projector ID are not matched.

Lamp Indicator
Indicator Condition Projector Condition Note

Off Normal –
Blinking 
light

Red Lamp has reached its end of life. Lamp 
replacement message will be displayed.

Replace the lamp.

Steady 
light

Red Lamp has been used beyond its limit. The 
projector will not turn on until the lamp is 
replaced.

Replace the lamp.

Green [ECO MODE] is set to [NORMAL] or [ECO] –
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Over-Temperature Protection
If the temperature inside the projector rises too high, the over-temperature protector will automatically turn off the lamp 
with the STATUS indicator blinking (2-cycle On and Off.)
Should this happen, do the following:
•	 Unplug the power cord after the cooling fans stop.
•	 Move the projector to a cooler location if the room where you are presenting is particularly too warm.
•	 Clean the vents if they are clogged with dust.
•	 Wait about 60 minutes until the inside of the projector becomes cool enough.
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Common Problems & Solutions
(→ “Power/Status/Lamp Indicator” on page 122.)

Problem Check These Items

Does not turn on
or shut down

•	 Check that the power cord is plugged in and that the power button on the projector cabinet or the remote 
control is on. (→ pages 13, 14)

•	 Ensure that the lamp cover is installed correctly. (→ page 118)
•	 Check to see if the projector has overheated. If there is insufficient ventilation around the projector or if the 

room where you are presenting is particularly warm, move the projector to a cooler location.
•	 Check to see if you continue to use the projector for another 100 hours after the lamp has reached the end 

of its life. If so, replace the lamp. After replacing the lamp, reset the lamp hours used. (→ page 116)
•	 The lamp may fail to light. Wait a full minute and then turn on the power again.
•	 Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 5500 feet/1700 

meters or higher. Using the projector at altitudes approximately 5500 feet/1700 meters or higher without 
setting to [HIGH ALTITUDE] can cause the projector to overheat and the projector could shut down. If this 
happens, wait a couple minutes and turn on the projector. (→ page 65)

	 If you turn on the projector immediately after the lamp is turned off, the fans run without displaying an 
image for some time and then the projector will display the image. Wait for a moment.

Will turn off •	 Ensure that the [OFF TIMER] or [AUTO POWER OFF] is off. (→ page 59, 68)

No picture •	 Use the COMPUTER1, HDMI1/MHL, HDMI2, VIDEO, USB-B, or APPS button on the remote control to select 
your source (COMPUTER, HDMI1/MHL, HDMI2, VIDEO, USB-B, or APPS). (→ page 16) If there is still no 
picture, press the button again.

•	 Ensure your cables are connected properly.
•	 Use menus to adjust the brightness and contrast. (→ page 52)
•	 Reset the settings or adjustments to factory preset levels using the [RESET] in the Menu. (→ page 74)
•	 Enter your registered keyword if the Security function is enabled. (→ page 35)
•	 Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning 

on the power to the notebook PC.
	 In most cases the output signal from the notebook PC is not turned on unless connected to the projector 

before being powered up.
*	 If the screen goes blank while using your remote control, it may be the result of the computer’s screen-

saver or power management software.
•	 See also the next page.

Picture suddenly 
becomes dark

•	 Check if the projector is in the Forced ECO mode because of too high ambient temperature. If this is the 
case, lower the internal temperature of the projector by selecting [HIGH] for [FAN MODE]. (→ page 65)

Color tone or hue is 
unusual

•	 Check if an appropriate color is selected in [WALL COLOR]. If so, select an appropriate option. (→ page 
59)

•	 Adjust [HUE] in [PICTURE]. (→ page 52)

Image isn’t square to 
the screen

•	 Reposition the projector to improve its angle to the screen. (→ page 17, 18)
•	 Use the Keystone correction function to correct the trapezoid distortion. (→ page 21)

Picture is blurred •	 Adjust the focus. (→ page 18)
•	 Reposition the projector to improve its angle to the screen. (→ page 17, 18)
•	 Ensure that the distance between the projector and screen is within the adjustment range of the projection 

window. (→ page 75)
•	 Condensation may form on the lens if the projector is cold, brought into a warm place and is then turned 

on. Should this happen, let the projector stand until there is no condensation on the lens.

Flicker appears on 
screen

•	 Set [FAN MODE] to other than [HIGH ALTITUDE] mode when using the projector at altitudes approximately 5500 
feet/1700 meters or lower. Using the projector at altitudes less than approximately 5500 feet/1700 meters and setting 
to [HIGH ALTITUDE] can cause the lamp to overcool, causing the image to flicker. Switch [FAN MODE] to [AUTO]. 
(→ page 65)

Image is scrolling 
vertically, horizontally 
or both

•	 Check the computer’s resolution and frequency. Make sure that the resolution you are trying to display is 
supported by the projector. (→ page 131)

•	 Adjust the computer image manually with the Horizontal/Vertical in the [IMAGE OPTIONS]. (→ page 54)

Remote control does 
not work

•	 Install new batteries.(→ page 10)
•	 Make sure there are no obstacles between you and the projector.
•	 Stand within 22 feet (7 m) of the projector. (→ page 10)

Indicator is lit or 
blinking

•	 See the POWER/STATUS/LAMP Indicator. (→ page 122)
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Problem Check These Items

Cross color in RGB 
mode

•	 Press the AUTO ADJ. button on the projector cabinet or the remote control. (→ page 23)
•	 Adjust the computer image manually with [CLOCK]/[PHASE] in [IMAGE OPTIONS] in the menu. (→ page 

53)

Mic sound is not 
heard

•	 Check if your microphone cable is connected to the MIC input jack correctly.
•	 Check if selection of microphone type in the installation menu is correct.

Mic sound is too loud 
or quiet

•	 Adjust [MIC GAIN] from the menu. (→ page 64)

The stylus pen does 
not work.

•	 Has calibration performed properly?
•	 Does the stylus pen have proper charge?
	 If red LED is not turned on by pressing the pen tip, charge the stylus pen.

Lines traced with the 
stylus pen do not 
match lines indicated 
on the screen.

•	 Has calibration performed properly?
	 If it does not solve the problem by performing automatic calibration, try to perform manual calibration.
•	 Change the place to install them avoiding to receive direct sunshine or strong light.
	 When the projector is mounted beside a window, avoid receiving influence of light from outside by ap-

propriate measures as closing a curtain and keeping a certain distance from the window, etc.

For more information contact your dealer.

If there is no picture, or the picture is not displayed correctly.
•	 Power on process for the projector and the PC.
	 Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on the 

power to the notebook PC.
	 In most cases the output signal from the notebook PC is not turned on unless connected to the projector before 

being powered up.
NOTE: You can check the horizontal frequency of the current signal in the projector’s menu under Information. If it reads “0kHz”, 
this means there is no signal being output from the computer. (→ page 71 or go to next step)

•	 Enabling the computer’s external display.
	 Displaying an image on the notebook PC’s screen does not necessarily mean it outputs a signal to the projector. 

When using a PC compatible laptop, a combination of function keys will enable/disable the external display. Usually, 
the combination of the “Fn” key along with one of the 12 function keys gets the external display to come on or off. 
For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle through external 
display selections.

•	 Non-standard signal output from the computer
	 If the output signal from a notebook PC is not an industry standard, the projected image may not be displayed 

correctly. Should this happen, deactivate the notebook PC’s LCD screen when the projector display is in use. Each 
notebook PC has a different way of deactivate/reactivate the local LCD screens as described in the previous step. 
Refer to your computer’s documentation for detailed information.

•	 Image displayed is incorrect when using a Mac
	 When using a Mac with the projector, set the DIPswitch of the Mac adapter (not supplied with the projector) accord-

ing to your resolution. After setting, restart your Mac for the changes to take affect.
	 For setting display modes other than those supported by your Mac and the projector, changing the DIP switch on 

a Mac adapter may bounce an image slightly or may display nothing. Should this happen, set the DIP switch to 
the 13" fixed mode and then restart your Mac. After that, restore the DIP switches to a displayable mode and then 
restart the Mac again.
NOTE: A Video Adapter cable manufactured by Apple Inc. is needed for a MacBook which does not have a mini D-Sub 15-pin terminal.

•	 Mirroring on a MacBook
*	 When using the projector with a MacBook, output may not be set to 1024 × 768 unless “mirroring” is off on your 

MacBook. Refer to owner’s manual supplied with your Mac computer for mirroring.
•	 Folders or icons are hidden on the Mac screen
	 Folders or icons may not be seen on the screen. Should this happen, select [View] → [Arrange] from the Apple 

menu and arrange icons.
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❷ Specifications
This section provides technical information about projector’s performance.

Optical

Model Number NP-UM352W
LCD Panel 0.59 inch LCD with Micro Lens Array (Aspect Ratio 16:10)
Resolution*1 1280 × 800 pixels (WXGA)
Lens Digital zoom and manual focus

Digital Zoom Ratio = 1.4
F = 1.8  f = 4.78 mm

Lamp 255 W AC 
(200 W in NORMAL)
(160 W in ECO)

Light Output*2*3 3500 lumens
NORMAL: 80%
ECO: 60%*4

Contrast Ratio*3

(full white: full black)
4000:1

Image Size (Diagonal) 58 - 110 inches/1473 - 2794 mm
Projection Distance
(Min.–Max.)

18 - 34 inches/448 - 854 mm

Projection Angle 49°

*1	 Effective pixels are more than 99.99%.
*2	 This is the light output value (lumens) when the [PRESET] mode is set to [HIGH-BRIGHT]. If any other mode is selected as the 

[PRESET] mode, the light output value may drop slightly.
*3	 Compliance with ISO21118-2005
*4	 The maximum power becomes equivalent to power in NORMAL (ECO MODE).

Electrical

Model Number NP-UM352W
Inputs 1 × RGB/Component (D-Sub 15 P), 2 × HDMI Type A (19P, HDMI® Terminal) HDCP supported*5, Ex-

clusively HDMI1 supports MHL signals, 1 × Video (RCA), 1 × (L/R) RCA Audio, 1 × Stereo Mini Audio
Outputs 1 × RGB (D-Sub 15P), 1 × Stereo Mini Audio
PC Control 1 × PC Control Port (D-Sub 9P)
Wired LAN Port 1 × RJ-45 (10BASE-T/100BASE-TX)
Wireless LAN Port  
(Optional)

IEE 802.11 b/g/n (optional USB Wireless LAN Unit required)

USB Port 1 × Type A, 1 × Type B
MIC Input 1 × Monaural Mini Audio (Dynamic michrophone and Condenser microphone)
Color Reproduction 10-bit signal processing (1.07 billion colors) (USB-B, APPS: Colors, 16.7 million colors)
Compatible Signals*6 Analog: VGA/SVGA/XGA/WXGA/Quad-VGA/SXGA/SXGA+/WXGA+/WXGA++/UXGA/WSXGA+/HD/

Full HD/WUXGA/Mac13", 16", 21", 23"
Component: 480i/480p/576i/576p/720p/1080i/1080p
HDMI: VGA/SVGA/XGA/WXGA/Quad-VGA/SXGA/SXGA+/WXGA+/WXGA++/WSXGA+/480p/576p/7
20p/1080i/1080p

Horizontal Resolution 540 TV lines: NTSC/NTSC4.43/PAL/PAL-M/PAL-N/PAL60
300 TV lines: SECAM

Scan Rate Horizontal: 15 kHz to 100 kHz (RGB: 24 kHz or over)
Vertical: 50 Hz to 120 Hz (HDMI: 50 Hz to 85 Hz)

Sync Compatibility Separate Sync
Built-in Speaker 20 W (monaural)

*5	 HDMI® (Deep Color, Lip Sync) with HDCP
	 What is HDCP/HDCP technology?
	 HDCP is an acronym for High-bandwidth Digital Content Protection. High bandwidth Digital Content Protection (HDCP) is a system 

for preventing illegal copying of video data sent over a High-Definition Multimedia Interface (HDMI).
	 If you are unable to view material via the HDMI input, this does not necessarily mean the projector is not functioning properly. With 

the implementation of HDCP, there may be cases in which certain content is protected with HDCP and might not be displayed 
due to the decision/intention of the HDCP community (Digital Content Protection, LLC).

	 Video: Deep Color; 8/10/12-bit, LipSync
	 Audio: LPCM; up to 2 ch, sample rate 32/44.1/48 KHz, sample bit; 16/20/24-bit
*6	 An image with higher or lower resolution than the projector’s native resolution (1280 × 800) will be displayed with Advanced Ac-

cuBlend. (→ page 131)
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Model Number NP-UM352W
Power Requirement 100–240V AC, 50/60Hz
Input Current 3.9A/1.7A
Power Con-
sumption

ECO MODE 
OFF

339 W (100-130 V)/326 W (200-240 V)

NORMAL 269 W (100-130 V)/261 W (200-240 V)
ECO 222 W (100-130 V)/216 W (200-240 V)
STANDBY 
(NETWORK 
STANDBY)

2.3 W (100-130 V)/2.6 W (200-240 V)

STANDBY 
(NORMAL)

0.22 W (100-130 V)/0.39 W (200-240 V)

Mechanical

Model Number NP-UM352W
Installation
Orientation

Desktop/Front, Desktop/Rear, Ceiling/Front, Ceiling/Rear

Dimensions 14.9" (W) × 4.4" (H) × 16.9"(D)/378 mm (W) × 112 mm (H) × 428 mm (D)
(not including protrusions)

Weight 5.8 kg/12.8 lbs
Environmental 
Considerations

Operational Temperatures : 41° to 104°F (5° to 40°C),
(ECO mode selected automatically at 95°F to 104°F/35°C to 40°C)
20% to 80% humidity (non-condensing)
Storage Temperatures : 14° to 122°F (-10° to 50°C),
20% to 80% humidity (non-condensing)
Operating altitude: 0 to 2600 m/8500 feet (Set [FAN MODE] to [HIGH ALUTITUDE] when using the 
projector at altitudes approximately 1700 m /5500 feet)

Regulations UL/C-UL Approved (UL 60950-1, CSA 60950-1)
Meets DOC Canada Class B requirements
Meets FCC Class B requirements
Meets AS/NZS CISPR.22 Class B
Meets EMC Directive (EN55022, EN55024, EN61000-3-2, EN61000-3-3)
Meets Low Voltage Directive (EN60950-1, TÜV GS Approved)

For additional information visit:
US : http://www.necdisplay.com/
Europe : http://www.nec-display-solutions.com/
Global : http://www.nec-display.com/global/index.html
For information on our optional accessories, visit our website or see our brochure.

The specifications are subject to change without notice.

http://www.necdisplay.com/
http://www.nec-display-solutions.com/
http://www.nec-display.com/global/index.html
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❹ Mounting the wireless receiver (sold separately)
For using the separately sold wireless receiver onto the projector mounted by the ceiling mount unit or the wall mount 
unit, tie the wireless receiver with the projector by the supplied strap for the prevention measure from dropping down.

1.	 Connect the HDMI cable supplied the wireless receiver to the 
projector.

•	 Please refer to the wireless receiver user's manual about the 
cable connection.

2.	 Attaching the cable cover to the projector. (→ page 5)

3.	 Prepare the screw enclosed with the wireless receiver and the 
strap enclosed with the projector.

	 Put the screw thread into the circle at the strap end.

4.	 Fasten the screw attached at the strap end to the screw setting 
hole at the rear face of the wireless receiver.

5.	 Take the another end of strap around the projector fixing 
screw on the ceiling mount or wall mount unit and then pass 
the wireless receiver through the strap circle for hanging it 
from the projector.

6.	 Store the wireless receiver connected with the projector by 
the strap at the cable cover inside.
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❺ Pin Assignments of D-Sub COMPUTER Input Terminal
Mini D-Sub 15 Pin Terminal

Signal Level
Video signal : 0.7Vp-p (Analog)
Sync signal : TTL level

51 42 3
10

11 12 13 14 15
6 97 8

Pin No. RGB Signal (Analog) YCbCr Signal
1 Red Cr
2 Green or Sync on Green Y
3 Blue Cb
4 Ground
5 Ground
6 Red Ground Cr Ground
7 Green Ground Y Ground
8 Blue Ground Cb Ground
9 Hotplug
10 Sync Signal Ground
11 No Connection
12 Bi-directional DATA (SDA)
13 Horizontal Sync or Composite 

Sync
14 Vertical Sync
15 Data Clock

COMPUTER IN
NOTE: Pin Nos. 12 and 15 are required for DDC/CI.
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❻ Compatible Input Signal List

Analog RGB

Signal
Resolution

( dots )
Aspect Ratio

Refresh Rate
( Hz )

VGA 640 × 480 4:3 60/72/75/85/
iMac

SVGA 800 × 600 4:3 56/60/72/75/85/
iMac

XGA 1024 × 768 4:3 60/70/75/85/
iMac

WXGA 1280 × 768 *1 15:9 60
1280 × 800 *1 16:10 60
1360 × 768 *2 16:9 60
1366 × 768 *2 16:9 60

Quad-VGA 1280 × 960 4:3 60/75
SXGA 1280 × 1024 5:4 60/75
SXGA+ 1400 × 1050 4:3 60
WXGA+ 1440 × 900 16:10 60
WXGA++ 1600 × 900 *2 16:9 60
UXGA 1600 × 1200 *3 4:3 60
WSXGA+ 1680 × 1050 16:10 60
HD 1280 × 720 16:9 60
Full HD 1920 × 1080 16:9 60
WUXGA 1920 × 1200 *4 16:10 60
MAC 13" 640 × 480 4:3 67
MAC 16" 832 × 624 4:3 75
MAC 19" 1024 × 768 4:3 75
MAC 21" 1152 × 870 4:3 75
MAC 23" 1280 × 1024 5:4 65

Component

Signal Format Aspect Ratio
Refresh Rate

( Hz )
HDTV (1080p) 1920 × 1080 16:9 50/60
HDTV (1080i) 1920 × 1080 16:9 50/60
HDTV (720p) 1280 × 720 16:9 50/60
SDTV (480p) 720 × 480 4:3/16:9 60
SDTV (576p) 720 × 576 4:3/16:9 50
SDTV (480i) 720 × 480 4:3/16:9 60
SDTV (576i) 720 × 576 4:3/16:9 50

MHL

Signal Format Aspect Ratio
Refresh Rate

( Hz )
VGA 640 × 480 4:3 60
HDTV(1080p) 1920 × 1080 16:9 50/60
HDTV(1080i) 1920 × 1080 16:9 50/60
HDTV(720p) 1280 × 720 16:9 50/60
SDTV(480p) 720 × 480 4:3/16:9 60
SDTV(576p) 720 × 576 4:3/16:9 50
SDTV(480i) 720 × 480 4:3/16:9 60
SDTV(576i) 720 × 576 4:3/16:9 50

*1	Native resolution
*2	The projector may fail to display these signals correctly when [AUTO] 

is selected for [ASPECT RATIO] in the on-screen menu.
	 The factory default is [AUTO] for [ASPECT RATIO]. To display these 

signals, select [16:9] for [ASPECT RATIO].
*3	WXGA MODE: OFF
*4	WXGA MODE: ON
*5	RB (Reduced blanking signal) is effective up to 154MHz.

NOTE:
•	 An image with higher or lower resolution than the projector’s native resolution (1280 × 800) will be displayed with Advanced 

AccuBlend.
•	 Sync on Green and Composite sync signals are not supported.
•	 Signals other than those specified in the table above may not be displayed correctly. If this should happen, change the refresh 

rate or resolution on your PC. Refer to Display Properties help section of your PC for procedures.

Composite Video/S-Video

Signal Aspect Ratio
Refresh Rate

( Hz )
NTSC 4:3 60
PAL 4:3 50
PAL60 4:3 60
SECAM 4:3 50

HDMI

Signal
Resolution

( dots )
Aspect Ratio

Refresh Rate
( Hz )

VGA 640 × 480 4:3 60
SVGA 800 × 600 4:3 60
XGA 1024 × 768 4:3 60
WXGA 1280 × 768 *1 15:9 60

1280 × 800 *1 16:10 60
1366 × 768 16:9 60

Quad-VGA 1280 × 960 4:3 60
SXGA 1280 × 1024 5:4 60
SXGA+ 1400 × 1050 4:3 60
WXGA+ 1440 × 900 16:10 60
WXGA++ 1600 × 900 16:9 60
WSXGA+ 1680 × 1050 16:10 60
WUXGA 1920 × 1200 16:10 60*5

HDTV (1080p) 1920 × 1080 16:9 50/60
HDTV (1080i) 1920 × 1080 16:9 50/60
HDTV (720p) 1280 × 720 16:9 50/60
SDTV (480p) 720 × 480 4:3/16:9 60
SDTV (576p) 720 × 576 4:3/16:9 50
SDTV(480i) 720 × 480 4:3/16:9 60
SDTV(576i) 720 × 576 4:3/16:9 50
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❼ PC Control Codes and Cable Connection
PC Control Codes

Function	 Code Data

POWER ON	 02H	 00H	 00H	 00H	 00H	 02H

POWER OFF	 02H	 01H	 00H	 00H	 00H	 03H

INPUT SELECT COMPUTER	 02H	 03H	 00H	 00H	 02H	 01H	 01H	 09H

INPUT SELECT HDMI1/MHL	 02H	 03H	 00H	 00H	 02H	 01H	 1AH	 22H

INPUT SELECT HDMI2	 02H	 03H	 00H	 00H	 02H	 01H	 1BH	 23H

INPUT SELECT VIDEO	 02H	 03H	 00H	 00H	 02H	 01H	 06H	 0EH

INPUT SELECT APPS	 02H	 03H	 00H	 00H	 02H	 01H	 20H	 28H

INPUT SELECT USB-B	 02H	 03H	 00H	 00H	 02H	 01H	 22H	 2AH

PICTURE MUTE ON	 02H	 10H	 00H	 00H	 00H	 12H

PICTURE MUTE OFF	 02H	 11H	 00H	 00H	 00H	 13H

SOUND MUTE ON	 02H	 12H	 00H	 00H	 00H	 14H

SOUND MUTE OFF	 02H	 13H	 00H	 00H	 00H	 15H

NOTE: Contact your local dealer for a full list of the PC Control Codes if needed.

Cable Connection
Communication Protocol

Baud rate	�����������������������������������������38400 bps
Data length	��������������������������������������8 bits
Parity	�����������������������������������������������No parity
Stop bit	��������������������������������������������One bit
X on/off	��������������������������������������������None
Communications procedure	�������������Full duplex

NOTE: Depending on the equipment, a lower baud rate may be recommended for long cable runs.

PC Control Terminal (D-SUB 9P)

1 52 43

6 7 98

To GND of PC

To RxD of PC

To TxD of PC

To RTS of PC

To CTS of PC

NOTE 1: Pins 1, 4, 6 and 9 are no used.

NOTE 2: Jumper “Request to Send” and “Clear to Send” together on both ends of the cable to simplify cable connection.

NOTE 3: For long cable runs it is recommended to set communication speed within projector menus to 9600 bps.
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❽ Update the Software
Using the web browser on a computer, download the updated software for the projector from our web site and install 
it on the projector by the wired LAN connection.

NOTE:
•	 The exclusive web browser enables to update the software is Internet Explorer 11.
•	 Before performing the software update, make sure to connect your computer with the projector by the LAN cable. It does not 

support the wireless LAN connection.
•	 Make sure to set [NETWORK STANDBY] as the standby mode of the projector. Factory default setting for the standby mode is 

[NORMAL] (→ page 67)
•	 The software update is enabled only when the projector is in standby condition. While performing the software update, do not 

power on the projector. At the same time, do not shut down the AC power.
•	 Never update the browser page during the software update. It disables the computer for displaying the web page correctly.

1.	 Access to the software download support page in our web site.

	 URL: http://www.nec-display.com/dl/en/pj_soft/lineup.html

2.	 Check if the software installed on the projector in use is updated.

•	 You can check the software version from either [VERSION(1)] or [VERSION(2)] in the onscreen menu [INFOR-
MATION].

3.	 If newer software version than one on the projector in use is uploaded on our website, download and save 
it in an appropriate folder on your computer.

4.	 Turn off the power of the projector and set it in the standby condition.

Important:
•	 Software update cannot be performed when the standby mode is set at NORMAL.

5.	 Connect the projector with your computer by the LAN cable.

6.	 Start up the web browser on your computer and then input the following web address:

	 URL (for the software update): http://<Projector IP address>/update.html

	 The software update screen will be displayed on.

7.	 Click [Browse….] at the center of the screen and select the software you saved in the procedure 3.

•	 Check the file name indicated on the UPDATE FILE list.

8.	 Click [START UPDATING] at the center of the screen.

	 The screen display will change and your computer starts to update the software.

http://www.nec-display.com/dl/en/pj_soft/lineup.html
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NOTE:
•	 During the software update, pay attention to the follows:

-	 Do not turn off the AC Power for the projector.
-	 Do not reload or move the web page.
-	 Do not close the web page.

•	 When software update is completed properly, the below will be displayed on:

1.	 UPLOADING THE UPDATE FILE: COMPLETED

2.	 CHECKING THE UPDATE FILE: COMPLETED

3.	 WRITING IN THE UPDATE FILE: COMPLETED

4.	 COMPLETE UPDATING: PLEASE REBOOT.

9.	 Click [REBOOT] at the right bottom of the screen.

	 The software update is completed and the projector will go into the standby mode.

NOTE:
•	 If an error occurs during the software update, an error code in below will be displayed in the “UPDATING STATUS” column.
	 2001: Failed to upload the file.
	 2007: The uploaded file is too large.
	 2011: The uploaded file is broken.
	 2012: The uploaded file is broken.
	 The error codes other than above may be displayed.
	 If an error is found during the software update, turn on the projector and update the file again.
	 When the software update is not completed properly even if you tried to update several times, please consult your dealer.
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❾ Troubleshooting Check List
Before contacting your dealer or service personnel, check the following list to be sure repairs are needed also by 
referring to the “Troubleshooting” section in your user’s manual. This checklist below will help us solve your problem 
more efficiently.
*	 Print this page and the next page for your check.

Frequency of occurrence  □ always  □ sometimes (How often?_____________________)  □ other (__________________)

Power
□	 No power (POWER indicator does not light blue). See also “Status 

Indicator (STATUS)”.
□	 Power cord’s plug is fully inserted into the wall outlet.
□	 Main power switch is pressed to the ON position.
□	 Lamp cover is installed correctly .
□	 Lamp Hours Used (lamp operation hours) was cleared after 

lamp replacement.
□	 No power even though you press and hold the POWER button.

□	 Shut down during operation.
□	 Power cord’s plug is fully inserted into the wall outlet.
□	 Lamp cover is installed correctly .
□	 [AUTO POWER OFF] is turned off (only models with the [AUTO 

POWER OFF] function).
□	 [OFF TIMER] is turned off (only models with the [OFF TIMER] 

function).

Video and Audio
□	 No image is displayed from your PC or video equipment to the 

projector.
□	 Still no image even though you connect the projector to the PC 

first, then start the PC.
□	 Enabling your notebook PC’s signal output to the projector.

•	 A combination of function keys will enable/disable the exter-
nal display. Usually, the combination of the “Fn” key along 
with one of the 12 function keys turns the external display 
on or off. 

□	 No image (blue or black background, no display).
□	 Still no image even though you press the AUTO ADJUST button.
□	 Still no image even though you carry out [RESET] in the 

projector’s menu.
□	 Signal cable’s plug is fully inserted into the input terminal
□	 A message appears on the screen.

( _____________________________________________ )
□	 The source connected to the projector is active and available.
□	 Still no image even though you adjust the brightness and/or 

the contrast.
□	 Input source’s resolution and frequency are supported by the 

projector.
□	 Image is too dark.

□	 Remains unchanged even though you adjust the brightness 
and/or the contrast.

□	 Image is distorted.
□	 Image appears to be trapezoidal (unchanged even though you 

carry out the [KEYSTONE] adjustment).

□	 Parts of the image are lost.
□	 Still unchanged even though you press the AUTO ADJUST 

button.
□	 Still unchanged even though you carry out [RESET] in the 

projector’s menu.
□	 Image is shifted in the vertical or horizontal direction.

□	 Horizontal and vertical positions are correctly adjusted on a 
computer signal.

□	 Input source’s resolution and frequency are supported by the 
projector.

□	 Some pixels are lost.
□	 Image is flickering.

□	 Still unchanged even though you press the AUTO ADJUST 
button.

□	 Still unchanged even though you carry out [RESET] in the 
projector’s menu.

□	 Image shows flickering or color drift on a computer signal.
□	 Still unchanged even though you change [FAN MODE] from 

[HIGH ALTITUDE] to [AUTO].
□	 Image appears blurry or out of focus.

□	 Still unchanged even though you checked the signal’s resolution 
on PC and changed it to projector’s native resolution.

□	 Still unchanged even though you adjusted the focus.
□	 No sound.

□	 Audio cable is correctly connected to the audio input of the 
projector.

□	 Still unchanged even though you adjusted the volume level.
□	 AUDIO OUT is connected to your audio equipment (only models 

with the AUDIO OUT terminal).

Other
□	 Remote control does not work.

□	 No obstacles between the sensor of the projector and the 
remote control.

□	 Projector is placed near a fluorescent light that can disturb the 
infrared remote controls.

□	 Batteries are new and are not reversed in installation. 

□	 Buttons on the projector cabinet do not work (only models with the 
[CONTROL PANEL LOCK] function)
□	 [CONTROL PANEL LOCK] is not turned on or is disabled in 

the menu.
□	 Still unchanged even though you press and hold the EXIT button 

for a minimum of 10 seconds.
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In the space below please describe your problem in detail.

Information on application and environment where your projector is used

Installation environment

Screen size:	 inch
Screen type: � □ White matte  □ Beads  □ Polarization 

□ Wide angle  □ High contrast
Throw distance:	 feet/inch/m
Orientation:  □ Ceiling mount  □ Desktop
Power outlet connection:
□	 Connected directly to wall outlet
□	 Connected to power cord extender or other (the 

number of connected equipment______________)
□	 Connected to a power cord reel or other (the number 

of connected equipment______________)

Computer

Manufacturer:

Model number:

Notebook PC □ / Desktop □

Native resolution:

Refresh rate:

Video adapter:

Other:

Video equipment

VCR, DVD player, Video camera, Video game or other

Manufacturer:

Model number:
Signal cable

NEC standard or other manufacturer’s cable?
Model number:            Length:        inch/m

Distribution amplifier
Model number:

Switcher
Model number:

Adapter
Model number:

Projector PC

DVD player

Projector

Model number:
Serial No.:
Date of purchase:
Lamp operating time (hours):
Eco Mode:	 □ OFF  □ AUTO ECO
	 □ NORMAL  □ ECO
Information on input signal:

Horizontal synch frequency	 [      ] kHz
Vertical synch frequency	 [      ] Hz
Synch polarity	 H □ (+)  □ (−)
	 V □ (+)  □ (−)
Synch type	 □ Separate  □ Composite
	 □ Sync on Green

STATUS Indicator:
Steady light	 □ Orange  □ Green
Flashing light	 [      ] cycles

Remote control model number:
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❿ TCO Certification
Some models in this product family are TCO certified. All TCO certified models have the TCO mark on the marking 
plate (on the bottom of the product). To see a list of our TCO certified projectors and their TCO Certification (in English 
only), visit our website at http://www.nec-display.com/ap/en_projector/tco/index.html
The TCO certification, designed by TCO Development, is an international environmental and ergonomics standard 
for IT equipment. 
In some cases we may post a list of TCO certified models on our website before the TCO mark is placed on the product. 
This difference in timing is related to the date certification is received compared with the projectors manufacturing date.

http://www.nec-display.com/ap/en_projector/tco/index.html
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⓫ REGISTER YOUR PROJECTOR! (for residents in the United 
States, Canada, and Mexico)

Please take time to register your new projector. This will activate your limited parts and labor warranty and InstaCare 
service program.
Visit our web site at www.necdisplay.com, click on support center/register product and submit your completed form online.
Upon receipt, we will send a confirmation letter with all the details you will need to take advantage of fast, reliable 
warranty and service programs from the industry leader, NEC Display Solutions of America, Inc.



© NEC Display Solutions, Ltd. 2015 7N952151
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